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& Artisteer i

Artisteer.net is a WordPress based Content Management System and a free hosting service for

running websites and online publishing. Together, Artisteer.net and Artisteer provide a complete user

friendly toolkit for creating and managing small and medium size website projects. You can manage

both the design and content of your website by creating templates, adding pages and posts, inserting

images and publishing the modified website on the web using one software.

Some features that make Artisteer.net special are:

Ready-made website samples. You can download free website projects developed by
professional web designers and modify them in Artisteer. There are numerous categories of
websites with ready-made layouts, which may serve as a source of ideas and a starting point
for your website project. You have the right to use all images and icons on your website but you
may not redistribute, or resell any Web Template, in any form. You are also not allowed to
make the Web Template, modified or unmodified, available for download from any website. For
more details, please refer to the license agreement at

http://www.artisteer.com/?p=license agreement).

The free samples can be downloaded from the official website of Artisteer at

http://www.artisteer.com/?p=free_website_templates. They can also be accessed from the

Artisteer startup dialog box.

Online & offline content editing with desktop software. The majority of Content Management
Systems require that you edit content online using their simplified HTML editor, while in
Artisteer you can edit the content offline using Artisteer on your desktop, or online using
Artisteer.net. This allows you to work on your website from just about anywhere.

Various Content Layout options. You have control over the number, size and position of
columns in the articles and posts.

Free hosting (200 Mb). You do not need to pay to have your website hosted and published on
the web; your web project can start and grow without the overhead expense normally

associated with establishing and managing a website.
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Artisteer.exe is the software you run on your desktop to create and style your web pages. When you
are ready, you can publish your website to Artisteer.net, where your site becomes visible to everyone
on the World Wide Web. You can edit your web content with Artisteer, but mostly Artisteer on the
desktop is about 'styling’, which is how you make your text, images, buttons, menus, and various other
elements appear in the browser. For example, when you add text to a page, you can define the font,
the font size, and the color. Most of the time, the 'style’ you create is kept in something called a
template (aka theme). You don't work with the template directly. This is done automatically for you as
you create your web pages. When your published webpages are copied to Artisteer.net, Artisteer
sends both the template and your content (e.g. text). On the web, viewers see your webpages after

the template (style) is applied to the content.

In the rest of the manual there are many references to the 'desktop’ and 'web' versions of Artisteer.
'‘Desktop’ refers to Artisteer.exe, or Artisteer running on your desktop. 'Web' refers to Artisteer.net.
After you publish your website, you can also create/edit/delete content on the web or on the desktop.
The major difference between the web and desktop is this. The style of your content (i.e. the template)
must be created on the desktop. You can style certain elements on the web, but mostly how you want
your web pages to look is done with Artisteer.exe. The web is used to manage features of your

website thru settings in the back-end (administrator) of Artisteer.net.

You can create content for your website (e.g. text and images) thru either the desktop or the web but
you should avoid using both at the same time. Whenever you publish your website from the desktop,
Artisteer will attempt to synchronize the content between the web and the desktop so you will see the
same pages, posts, and everything else. Just remember that whenever you make changes to your
content (on the web, or on the desktop), you should re-publish your website from the desktop each
time. This keeps the web and desktop synchronized. When you save your Artisteer project on the

desktop, you are saving both the theme and the content in your project file (e.g. myproject.artx).

Artisteer.net is not only where you host your website, but it also provides the backend to manage your
site. Once you publish your website and have a user account, you can go to www.artisteer.net, log in,
and begin adding, arranging, and moderating your content. You can also add or set features related to

how viewers can interact with your web pages (e.g. allow comments).

In the following sections, the manual often refers to ‘blogs’ and ‘static HTML websites’. For the

purposes of this manual, both terms refer to the same type of website. Artisteer makes no distinction
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between a static HTML website and a blog, but it is important to understand the difference when you
are making changes in Artisteer.net. A static web site consists of HTML pages where you normally
create the pages, publish them, and then infrequently make changes. When you create static web
pages in Artisteer, what your viewers see on your hosted website is what you see when you created
the page. A blog is a type of website where you are usually adding or changing the content frequently.
A blog website can include static HTML pages (‘pages’), but also pages which include blog posts (‘blog
pages’). Posts are articles (i.e. post content) that you, or others you invite, write and include into your
website. A blog website usually includes many features that allow you to communicate your ideas
(e.g. write articles), and interact with you viewers (e.g. allow them to enter comments about your
articles). A blog also includes many management features that you can use to manage how your
pages appear, manage what is on your pages, and manage options related to moderating your Posts,
Pages, Comments, Content, and Access. Artisteer.net is a Wordpress based hosting service and
offers many of the same features as Wordpress. Some of these features are applicable to any type of

website, and some are specific to blogs.

When you create your first Artisteer project, what you see is an example website with features
common to all blogs. The page has a background, a sheet, a header area at the top (with some text),
a horizontal menu bar, an article area with images and text, and a sidebar area (vertical menu, and
block), and a footer area with some links. These are all elements common to blogs. However, unlike
most blog software, like Wordpress.org, you can change the content (e.g. change the article text), and
style the content (e.g. change the appearance of the buttons on the menu) directly on your desktop
without any additional software, or without having to go to the web. This way, you can also see how
your web pages will look to your users since what you see in Artisteer on the desktop is the ‘style’ and

the content combined.

On the left side of your first project is a page folder (e.g. Page 1, Page 2). These are normally static
HTML pages. You pick a page, change the content on the page, and then style the content with

Artisteer.

You can also add blog posts directly in Artisteer. The post pages are automatically set as child pages
for one of your static pages. This page is referred to as the 'blog post' page. This page is used to
display a list of the post articles that you create. This page might include the full text of the post, or
just excerpts of the articles. Each post is also a separate page, so on your 'blog posts' page, if you
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click on the title, you are automatically redirected to the page for that post. This is a feature common

to all blogs.

If you choose to use post pages, then you need to consider other features common to blogs. For
example, do you want your viewers to know who wrote the article, or when the article was written? Do
you want to provide links to related articles? Do you want to allow viewers to comment on your
articles? Do you want to link to other blogs, or have other blogs link to yours? What kind of built-in
functionality do you want to include in your pages. For example, Artisteer.net supports several

Wordpress widgets, such as a Calendar, that you can include into your web pages.
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Design a plan of the website you would like to create. Specify the purpose, the target audience,
and design an overall strategy for your pages and content.

Download and install Artisteer.

Create a Website or Blog project (Artisteer start-up dialog - Website or Blog).

Implement your plan by adding/editing your web pages and posts with Artisteer.

Create your website on Artisteer .net (‘Create Website’).

Add/edit your pages on the desktop, or on Aristeer.net. Synchronize your pages and posts by
‘publishing’ your website again on the desktop.

Manage your website on Artisteer.net.
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Artisteer.net shares the Artisteer license. This means that unless you are a registered Artisteer user, or
have an active upgrade period, you can only use the trial version of Artisteer.net. All of the options in
the full version are available in trial mode, so you can create and design a website in Artisteer, publish
it to Artisteer.net, and then add more content and widgets on Artisteer.net. However, you cannot save
your *.artx project in trial mode; all of your design and content is discarded when you close Artisteer.
The Artisteer.net trial version also provides restricted disk space (only 10 MB), and the images taken
from the Artisteer image galleries will be watermarked. You will not be able to use a custom domain

name and you will have to activate your blog every 14 days after the first 30 days of usage.

If you have already published a website and then purchased the license or an upgrade, to activate
your website you need to open your *.artx project and publish the website to Artisteer.net one more
time. The information about the license will be automatically transferred to the system and your

website will be activated.

Trial Version Full Version
Free Disk Space 10 MB 200 MB
Artisteer Image Gallery unavailable available
Custom Domain unavailable available
The Usage of Blog free 30 day trial* unrestricted

After the 30 day trial, a notification will be sent to your e-mail, offering you to purchase Artisteer or continue using the trial

version within the next fourteen days. When this period expires, you will receive another notification.
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Artisteer.net may appear differently on your screen than it does in the following reference material and
tutorials.

e The size and proportion of your interface may be different from the size and proportion of
screen shots, provided in the current User’'s Manual.

e As the program is updated, features may be added or removed. If you are using the latest
version of Artisteer.net, you may see buttons and/or menu items that have been added or

removed since this User's Manual was written.

e Depending on your operating system and Windows system settings, dialogs and toolbars may
appear differently.
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The option groups in the Artisteer.net administration panel are arranged in tabs on the Ribbon bar.
Above the Ribbon bar is the login area. There are four main tabs: Home, Extras, Options and
Administration. The options under each tab are arranged in groups of icons. Clicking on an icon in one
of these groups, e.g. ‘Pages’, opens an administration screen. Each administration screen contains a

working area with specific settings.

! Home Extras Options Administration

- i _ — = “| Categories Available: 200 MB
alfla v 8 =
= s F Tags = Used: 23.41 MB {12%)
Preview Pages Mew Page Menus Posts MNew Post Comments Visit Site

Site Posts Browse Diskspace

Pageg Add New

All (14} | Published Scheduled Draft

Bulk Actions [=] | Apply Show all dates [=] | Fiter

[] Page Title Menu Caption Author
[[] (no titie) - Draft nemo

I ": allow comments allow comments nemo

Artisteer.net serves as the backend for managing your website. If you are familiar with Wordpress,
you should have no trouble using Artisteer.net. The administration pages are organized differently
from Wordpress, but the page content and the user interface is very similar. For example, each page
has a 'screen options' link in the top right corner of the page. You can use the screen options to
customize what appears on the page. For example, if you do not use the QuickPress tool, you might
want to exclude it in the future by turning this off in the screen options. This is very important because
as you are learning how to use Artisteer.net, you should always refer to the screen options since there

may be important features that are turned off by default.

The edit pages, such as edit post, edit link, etc., all have a ‘bulk actions’ feature. This is a drop down
box that always appears at the top of a list of elements (pages, posts, links, etc.). Since the list of
elements on a page (e.g. links) may be quite long, you will find that the bulk edit dropdown box is listed

at the top and the bottom of every list.
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Use ‘bulk actions’ to make a change to several elements (e.g. posts) at one time. Select the elements
you want to change with the checkboxes, and then select the type of change from the ‘bulk actions’
list. For example, if you want to delete several links at once, check off the links you want to target,
then 'bulk actions' - delete, and select the Apply button. To make a common ‘edit’ to multiple items,
select the elements you want to change (e.g. posts), select ‘edit’ and then the Apply button. From the
panel, select the ‘change’ you want to apply (e.g. allow comments), and then the Update button. This

will apply the same change to all the elements that you selected.

When a page includes a list of elements, such as the Posts page, all the elements are displayed in a
table. If you hover the cursor next to each table heading (e.g. Name), an arrow icon will appear next to
the heading showing the sort order of the list. Click on this icon to change the sort order. For
example, if you want to display your posts by name in descending or ascending order, click on the
direction icon next to Name on the Posts page. Most of the tables also include a checkbox at the top
where you can select, or unselect all of the items at one time. For example, the Pages page includes

a checkbox next to the Title heading. Selecting this checkbox will select all of the pages listed.

The editor is the same as in Wordpress, so the editor is not described below in detail. Generally, with
few exceptions, the editor features are all the same for the pages that include the editor. The editor
has a Visual mode where you can edit the content much like a simple wordprocessor. You can also
switch to HTML mode, but you need a rudimentary understanding of HTML, and working with an

HTML editor, to use it effectively.

When you have more than one website on Artisteer.net, you can change the default website when you
login (Extras-->Websites-->Primary Site).  This does not change the website you are currently
modifying, however you can always tell where you are by referring to the first part of the domain name
in the browser address bar. You can also easily change between websites by changing the URL. For
example, if you are editing 'mysitel’, the URL would be ‘mysitel.artisteer.net’. If you want to make
changes to ‘mysite2’, just change the URL to 'mysite2.artisteer.net’ and refresh the page. You can
also change websites using the Dashboard link (Extras—>Websites—>select the dashboard link next to

the website name).
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Artisteer.net is a Wordpress based hosting service. Unlike other hosting services, you can
create/edit/manage the content of your website using Artisteer on the desktop, or on the web using

Artisteer.net. To get started, you need to create a ‘website or blog’ project.

Mew Project

Websites and Blogs

Website or Blog Samples Online Samples

This is the only type of project that will work with Artisteer.net.

To get started, click the Suggest design button several times and find an attractive theme. Then adjust
the layout and specific options in the tabs, and optionally add/edit the content. When the design and

content are ready, click ‘Publish to Artisteer.net’ on the Home tab.

Home

ﬁg’SuggestColors | Suggest Background ] v c‘,;n E—;INEW Blog Post i L 2 ) Browse
Ed . v

i &Suggest Fonts [ Suggest Header {.thew Block d ¥ {} Edit
5uggest Design — - Styles Mew o Options Publish to | Publish to
L=] Suggest Layout =7 Suggest Menu - Page~ L& Delete Page Local/FTP | Artisteer.net
Design Ideas Website Export (]

When prompted you enter a title for your website and a domain name; the domain name must be

unique.
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Create Website ﬁ

¢ u Artisteer.net

Spedfy Tile and Domain for the new website.

Title: [onter Site Title |
Darnain: | | artisteer.net
Already Have Website? L\}

@ Help et Cancel Options...

Unless you later map a different domain to your website on Artisteer.net, users will access your
website with the domain name you provide (e.g. myname.artisteer.net). Once you enter a domain,
Artisteer will check if the domain is unique or not. If this is a unigue name, the 'Next' button will be

activated and you can proceed to create a user account.

If you have not used Artisteer.net before, you will be prompted to enter a username and an e-mail

address.

Create Website ﬁ

¢ u Artisteer.net

Create a new Artisteer.net account.

—H

Username: | |

Email; | |

Existing user?

© Help Back Create Cancel Options...

After you complete this, all of your web pages will be copied to Artisteer.net and a password will be
emailed to the address you provided. Afterwards, you can view your website online at the domain you

specified, or log into www.Artisteer.net, and make or change various settings related to your site. Once

your website has been created and published, you can create/edit/manage the content for your site
artisteer.net | page 17
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from either the desktop, or thru Artisteer.net. Any time afterwards, when you publish your website from
the desktop, your content on the web, and the content in your Artisteer project will be synchronized so

you always have the same view of your pages.

Your First Page

Let's look at an example. The left side of the picture below shows what your initial page should like in
the Preview area. The right side shows the basic layout and elements of the page that you will be

working with.

Page
Enter Site Title
Seury i Rogan Header
I I " 1 Horizontal Menu |
Emen PRE conas Sidebar Content
amn Lirhm b 04 G WL b |
il iy e o g ey
T il
O e —— 'i‘l'mkal
haw oty [k
o p— ‘ m |
ot P i oo S
L= fary b ol et
o sy ‘
- i aprriags [y pat ey it Ermbil ;
g e Mar & bl lude asd i Jr —— | L
- u.m:b ek b ;:‘1‘ ::E: e g e—— penrirutcd st y-slf i
A s s rEa e G i s bl 38 :T"::ph# m -1 :
Arve gl e ey mouTe !-: I
]
(W] PO Lo !
Block 2
Footer ]
Footnote

Inside the Article content is some sample text and an image. You will want to replace this content with

your own. Also, the Article section is divided into sections. One of the first things you will want to do is

select the layout for the various sections using the Content Layout icon on the Edit tab:
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EET =] Erowr
= o |

Content | Styling
LEyaut =

Cell -

Chre Codlurman

Columins

JRowis & i Caalidimiis

You can use the other icons in this group, such as the Styling icon, or the Row and Cell icons, to

change the appearance of these sections.

On the left side of the Artisteer window is a folder tree listing the pages to your website. If you add any
Post articles later they will be listed below your page list. To change the names of the pages, right-
click on the page name, and select Rename from the context menu. You can change the Preview

area to any page or post you want to work on by clicking on any of the items in the tree.

The Horizontal menu bar across the top is used to navigate the pages of your website. As you add

parent (or top-level pages) to your site, new items are added automatically to the menu.

The content in the Header area and the Article section can be changed directly in the Preview area.
Use the Edit tab on the ribbon bar to edit and style the content you create on your page. The other
tabs on the ribbon bar, such as the Vertical Menu tab and the Blocks tab are used to style the various
other elements of your page. Note, options on the ribbon bar under the Edit tab may be grayed out

until you place the cursor within an editable part of the Preview area (e.g. article text).

The Sidebar area of the page contains by default a Vertical Menu, followed by 1 or more blocks. If you
do not intend to include these elements on your page, you can remove them by clicking on each block,
then the Position icon, and No Block (or just select the Delete block icon next to the Position icon). To

remove the sidebar entirely, set your column layout to one column (Layout->Columns—->One column).
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Subpage 1
Mo Block
Subpage 2 0 Bloc
Subpage 3 ,‘_H—‘
New Block ' |I=X [E] - Block Position
______________ — -
Position |
Enter Block content here._'— - 2

Lorem ipsum dolor sit amet, |
consectetur adipiscing elit. =i
Etiam pharetra, tellus sit

amet congue vulputate, nisi | i
erat iaculis nibh, vitae feugiat — At
sapien ante eget mauris. |_J

T

Except for the Vertical Menu (and other defined widgets), you can normally edit the block content
directly (e.g. to create a list of hyperlinks), but typically the sidebar is used for widgets that you add to
your pages on the web using Artisteer.net. You cannot edit widgets since they are pre-defined content
areas, such as a Calendar, or a Search box. Widgets can be added with the Layout tab
(Layout->Blocks>Widgets).  There are several defined widgets you can use with Artisteer.net:
Vertical Menu, Search, Categories, Archives, Blogroll. You can also add blocks (editable) to your
sidebar with the Layout tab (Layout->Blocks—>New Block).

Once you have defined the layout, styling and content of your pages, you can use the Publish choice

on the top menu (or Home—->Export->Publish to Artisteer.net) to move your pages to Artisteer.net.

Although it is not shown, when you create a website for Artisteer.net, you are creating a theme as well
as the content of your pages. Like other templates that you can create with Artisteer, the theme
defines the styling applied to the way your content appears (e.g. how your navigation menu appears,
how the text on your pages appear, etc.). You do not work directly with the theme except thru the
‘styling’ options in Artisteer, but when you publish your website, your theme and content are published

together.

Every time you publish your website from the desktop, your theme and content is synchronized with

your theme and content on the web. For example, if you make any changes to your pages on
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Artisteer.net, the next time you publish your website from the desktop, your content is synchronized so
what you see on the web is the same as what you see on the desktop. You can make changes (e.g.
add pages or posts) either on the desktop or web, but you should try to avoid using both at the same
time. Also, you should Publish your project frequently from the desktop to make sure that your content
Is in sync. You should also save your projects frequently on the desktop and make sure you keep

backup copies of your designs.

Artisteer.net has all the features needed to administer your website, but you can also choose to
publish your website to your own hosting service. If you use your own host, you need to move your
pages to a remote location that your hosting service provides. Your hosting service will provide the
details about how to do this. (Note, this only applies to publishing a static HTML website. If you want
to use blog features like organizing your post articles by category, or moderating comments, then you
need to publish to Artisteer.net, or change your project type to another CMS. Also, if you are using, or
plan to use, a CMS with your hosting service, like Wordpress, you will need to change your Artisteer
project to a CMS template, File->Change Template. And also, please note that is not the same as

using your own domain name which is described in the section covering the Administration tab below.

From Artisteer, you can either export your pages to a folder or archive (i.e. zip file), and/or move the
files yourself later, or you can take advantage of Artisteer's FTP client to move the files. To use the
FTP client though, you must configure certain settings in your Export options (File->Export->Export
Options>FTP Server). You will need to get these settings from your hosting service. After you have
configured your settings, you can then export your files using the Home tab on the ribbon bar
(Home—->Publish>Export HTML website to FTP folder).  This only applies to static HTML type
websites where you want to use your own hosting service. If you are using Artisteer.net, your pages

and content are copied automatically to Artisteer.net every time you ‘publish’ your website.
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Export Options 53
W General FTP Server
{[g €SS Options |
Protocol: FTP .
‘=] Description '
Bll| Watermarc — Host[:Port]:
__| Footnate
7 Default Page Tags ] User Mame:
L FTP Server — Password:
1 Remote Directory L\\T

When you are creating a CMS template (e.g. Joomla, Wordpress, etc.), you are creating a style for
how your content will appear to your users but not the actual content. Except for a few things, like the
Header background and foreground, the content of your web page is created in the CMS, not in
Artisteer. What you see in the Preview area is only an example, or sample content, to help you see
the ‘look’ of the page. For example, you can define the font style, color, and size for text that appears
in an Article. When you create an Article later in the CMS, you do not have to define this look; all you
have to do is supply the text of the Article, and your text will appear on your web page in the style that

you defined in Artisteer.

When you create a ‘website or blog’ project, you can directly add or change your content directly in
Artisteer, and at the same time, you can also define a style for the various elements of the page (e.qg.
Header, Layout, Menu, etc.) The content you create, such as Article text can be published and viewed
on Artisteer.net, but you cannot publish the pages you create to any other CMS (e.g. Joomla,
Wordpress, etc.) since these CMSs are not designed to handle content in any other way except within

the CMS. You can reuse your style settings with other CMS templates, but not the content.

If you want to create a template for one of the other CMSs, use the File menu at the top of the Artisteer
window (File>Change Template). When you change the project template, you will probably notice
that the pages you created before have disappeared. Since the content cannot be used with any other

template type, the pages are hidden. The content is not lost; you can always go back to these pages
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by changing the template type back to ‘website or blog’. This does not apply to most of your style

settings. E.g. Any settings, such as the Header background, become part of the new template.
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There are two ways to write a post — either on the web (Artisteer.net > Home > New Post) or using the
desktop (Artisteer > Home > New Blog Post). These methods serve different purposes — working in
Artisteer.net requires a connection to the Internet; working with content on the desktop can be done
offline (though you need to be connected to the web eventually to publish your website to
Artisteer.net). Most bloggers are accustomed to working online. Editing the page and post content in
Artisteer.net will not be something new to them as it is very similar to WordPress. Normally though,
like working in Wordpress, when you create your content online, you don’t often see the visual
appearance of your pages in the HTML editor, even in Visual Mode because the ‘style’ and the content
are not combined. Using Artisteer on the desktop gives you more control over the design because in
the preview area, you see your changes just as your viewers will see the page on your website. This
is because what you see in Artisteer is the ‘style’ applied to the content; you do not have to visit your
published page to see how it will look to your viewers. For example, suppose you decide the text in
your articles should be ‘red’. On the desktop when you create your article, you should notice that the
text you enter for the article content appears in ‘red’. However, to create an article on Artisteer.net
(like other CMSs), you use the online HTML editor to enter the text. Unless you apply a different style
to the text, the text appears ‘black’ in the editor because ‘black’ is the default color. On your web
page, the text will be ‘red’ but you will not see this in the editor. You will not see the text in ‘red’ until

you preview your web page.
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Let us compare the options of 1) desktop editﬂing and 2) online editing.
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Custom Fields
Adding Content
Artisteer Artisteer.net

Front end editing (WYSIWYG): filling in the

content fields on the actual website pages

Clipboard: copy-paste text and images (from
Microsoft Word, etc.)

Editing Modes: visual mode and HTML mode
(Edit tab >HTML)

Back end editing: filling in the WordPress- looking
post fields

Clipboard:Copy-paste or type the text

Editing Modes: visual mode and HTML mode
(markup display)
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Inserting objects:link, image, video, add clip

art, table

Indentation: all text, first line

Extra: Content layout and styling options
(arrange content in columns and apply

different styles)

page

Inserting objects:link, image, video, audio, map

Inserting files (Extras >New Media): .doc, docx,

.pdf etc.

Indentation: first line

Extra: Featured image

Working with Meta Data

Artisteer

Designing Metadata: Metadata refers to the
attributes of your posts that make the post
more descriptive, or directs viewers to related
content. For example, you can include the
name of the post author and a link that viewers
can use to view other posts by the same
author. Artisteer has several design options
under the Content tab to determine the layout
of the post (headline, header, footer), and the
(e.q.
“Comments” link, “tags” link, etc.). The design

metadata to appear on the post

that you create is automatically applied to all

the posts on your website.

Artisteer.net

Generating metadata: The source of the metadata
is defined by the elements of your blog (such as
Categories, Tags, Comments, etc.). For example, if
you allow comments, comments can be created by
your website viewers, and then moderated using
Artisteer.net. You cannot however add or remove

‘comments” metadata from your post using
Artisteer.net; you have to do this on the desktop.
That is, if you want a “comments” link on your post
page so viewers can view all comments left for the
post, you have to add and style the link on the

desktop using the Content tab

(Content->Metadata—>Icons).
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Editing HTML
Artisteer Artisteer.net

Classical HTML editor with user friendly mark WordPress-like HTML editor with quicktags,
up, wide custom editing capabilities and preview after publishing

preview before exporting/publishing.

You can also style and edit separate cells
(layout with columns) or wrap the whole
article in one cell (Edit whole Article HTML)

In a nutshell, the comparison revealed specific features of editing systems, defining the different
purposes of the editors’ usage: Artisteer content editor showed greater potential for adding and editing
content, creating and adjusting design, previewing the article, and editing HTML while the editing
system of Artisteer.net is suitable for managing Meta data, creating custom menu, categorizing posts,

adding a featured image, and optimizing them for search engines.
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The Home tab is used to manage your pages and posts.

Home | Extras Options  Administration

: ; . : _ — e = Categories Available: 200 MB
Py : = g ; 4
-_\_- - Hﬁhj __I o |: | %l lfl:-l I
= ﬂ - A = P Tags < | Used: 0 MB (0%)
> Preview Pages Mew Page Menus Feedbacks Posts Mew Post | Comments Visit Site
Site Posts Browse Diskspace

I

The Preview icon displays what your website will look like. This is the same

as selecting the Visit Site icon except your web pages will appear below the
Preview ribbon bar. This only displays published pages.
You can also edit the content in Preview mode by clicking on the content
area. This is what you should see:
F
Edit Content
b i || link || b-quote | d&l || ins | img. | ul || ol || i || code || more || lookup || close
<p=<img src="http://nemo_artisteer net/wp-content/themes/nemo_152071/images/preview jp
image” id="preview-image” />Enter Page content here__</p=<p>_orem ipsum dolor sit amet
adipiscing elit. Etiam pharetra, tellus sit amet congue vulputate, nisi erat iaculis nibh. vitae f
ante eget mauris. Aenean sollicitudin imperdiet arcu, vitae dignissim est posuere id </p><p:
href="#">Fead more</a></p>
Update Cancel
j] The Pages icon displays a list of all the pages of your website where you can
Pages select and change the page or page options.
c:j Use the New Page icon to create a new page for your website. After you
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Menus

'E—ﬂ

Posts
=]

New Post

Categories

& Tags

Comments

page

have added new pages, use the Publish feature on the desktop to add the
pages (synchronize your content) to your Artisteer project.
Use the Menus icon to create, customize, and manage the menus on your

website.

The Posts icon displays a list of the post articles that have been added to

your web site.

Use the New Post icon to create new blog posts for your web site. After you
have added new posts, use the Publish feature on the desktop to add the
posts (synchronize your content) to your Artisteer project.

The Categories icon is used to manage the Categories of your blog. Use
this to add, delete, or change Categories. Categories are used to organize
your posts. This makes it easier for your viewers to find particular posts by
subject. Also, each category has its own RSS feed so viewers can subscribe
to and get updated on topics of interest to them.

The Tags icon is used to manage the Tags of your blog. Use this to add,
delete or change Tags. Tags are keywords you can use to further organize
your posts so your viewers can more quickly find relevant articles. Unlike
Categories, tags have no hierarchy. There is no inherent organization such

as parent and child tags.

Search-engines inventory your tags so they are very important to attracting
viewers to your website.

Use the Comments tag to manage the comments added to your web site.
Comments are submitted by your web site viewers (you can also add
comments of your own or reply to comments). Use this page to manage the
comments submitted. Use it to view, delete, approve/unapprove, or mark

comments as spam.
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Use this icon to open a new browser tab or browser window on the first page

o
of your web site. This displays only your published pages and posts.
Visit Site
Diskspace This statistic (also on the dashboard) displays the amount of disk space

currently used for your web site. If you are a licensed user of Artisteer, you

have 200MB of space available on Artisteer.net.

The Preview page will show you what your published pages will look like, while keeping the
Artisteer.net Ribbon bar still visible and accessible in the browser. Only your published changes are

visible (as opposed to ‘draft’ or ‘pending’).
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Home Extras Options Adrministration

, , = Categories Available: 200 MB
() j '-ﬂ’j ) E _J| = i g - vailable:
= - | — =" = Tags = Used: 5,54 MB (3%)
Preview Pages MNew Page Menus Posts Mew Post Comments Visit Site
Site Posts Browse Diskspace

Home Practices “ References

Law Offices Of

You can also edit the content and HTML in Preview mode by clicking on the content area. This is what
you should see:

r

Edit Content

1] i link | b-quote | de | ins || img || ul | ol | li | code | more | lookup | closetags

<p><img src="http://nemo. artisteer.net/wp-content’themes/nemo_152071/images/preview.jpg" alt=
image” id="preview-image"” />Enter Page content here_._</p><p=_orem ipsum dolor sit amet. cons

adipiscing elit. Etiam pharetra, tellus sit amet congue vulputate, nisi erat iaculis nibh. vitae feugiat
ante eget mauris. Aenean sollicitudin imperdiet arcu, vitae dignissim est posuere id </p><p><a

href="#">Read more</a></p>

Update Cancel
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This page lets you manage the pages of your website. You can add or delete pages from here,

change the order of the pages that appear on your website, track revisions, and change various other
options of your pages.

Use the Search Pages box to search for pages by title, or their content. You can also use the ‘filter’

option to show only those pages created/updated this month, or all pages created for your site.

After making changes to a page or posts, always save your changes. If you are not ready for your

changes to be visible to viewers of your blog, set your page or post to ‘draft’ or ‘pending review’ status
and then save your changes.

Home Extras Options Administration

=N iy = (== P — =1 Categories - Available: 200 MB
C j “Jj =] =] 4 Q) .
i = @ Tags % Used: 23.41 MB (12%)
Preview Pages New Page Menus Posts Mew Post | Comments Visit Site
Site Posts Browse Diskspace
Screen Options =
F’ages Add New
Search Pages
All 1 Published Scheduled (1) | Draft
Bulk Actions [=] | Apply Show all dates [=] | Fiter
| Page Title = Menu Caption Author L Date
| '5 (no title) - Draft nemo 2011408431

Last Modified

When you create or update a page or post, the page can be in set to one of 3 states:

e Draft — The page or post has not been published yet. Viewers cannot see the page or post (or

the changes applied) until the page or post is published.

e Pending View- The page or post has not been published yet. This is the same as ‘Draft’ status

except the page or post is visible to editors as being in a pending state awaiting review before
being published.

e Published - The page or post has been published to your website and is now visible to your

viewers. You can publish your pages immediately, or select a date/time when Artisteer.net will
add your changes to the website.

You can also set the ‘visibility’ mode to one of three states:
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e Public — Your page or post is visible to anyone when your content is published.

e Private — Your page or post is visible only to those with the same credentials as you (e.g.
Administrator).

e Password Protected — Your page or post is visible only to those who supply the password you
establish to restrict who has access to the content. For a published page or post, only those

with the correct password can see the content.

When you hover the cursor over any page title, you should notice that a menu appears underneath the
title (‘edit’ | ‘quick edit’ | ‘trash’ | ‘view’). Edit and Quick Edit are described below. ‘View’ lets you see
what your page currently looks like on your website. The Trash option is used to remove pages you
no longer want. Above the list of your pages, you should see a ‘Trash’ link. This link only appears if
you have pages in your trash bin. If you later want to restore one of your pages, click on this link,
move the cursor over the page you want to restore and select the Restore link that appears below the
page name. However, if you Permanently Delete the page, or the trash bin has been emptied, you

cannot restore the page.

Use quick edit from the page menu to quickly configure common attributes of your pages. Always use

the Update button on this panel, otherwise your edits will be discarded.

| Titie Author ] Date
QUICK EDIT
Title Page 1 Farent Main Page (no parent) E|
Slug new-page-3 Order 0
Date [isep [=] 22 2011 |@|23|:[10 Template | Defautt Template [ |
Password —0R- || Private [ Allow Comments
Status Published =
Cancel Update
Page Title Short description of your page. ‘Page Title’ is what appears as the heading

for your page and the menu choice for the page in your navigation menu

(horizontal menu).
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Date

Parent

Order

Allow Comments

Status

Password or

Private

page

Slug is an URL friendly version of the title generated by Artisteer.net. Slugs
are used with Permalinks. E.g. http://mydomain.artisteer.net/my-dog-page
Use this to either backdate the date and time the page was published, or
schedule a date and time when the page should be published. Note, this
depends on the Timezone option in your General settings
(Options—> Settings—> General-> Timezone).

Assign a parent page if you want this page to be a child. On the navigation
menu, child pages appear as submenu items.

Change this to rearrange the order that you want your pages to appear either
on the navigation bar, or within a submenu. This also affects how your pages
will appear in the page folder on the desktop.

Select this if you want to allow viewers to comment on your pages.

Use this to assign a status to the changes you have made. If you do not
want the changes to be applied and published right away, set the status to
‘Pending Review’ or ‘Draft’. These status codes are used to describe the
state of your changes. ‘Draft’ means you anticipate more changes. ‘Pending
Review’ tells other Editors or Administrators that the page is ready for

publication, pending moderation.

You might also see the status as ‘scheduled’. This means that you have
defined a date and time in the future when this page should be published.

Select ‘private’ if you want the page to be visible only to you (e.qg.
administrator). Enter a password, if you want the page visible only to viewers

who supply the correct password.
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Edit

Use the Edit page to edit the full range of features and attributes of your pages. Always use the

Publish panel to apply your changes; otherwise your edits will be discarded.

Sireen Options =

Edit Page
Page 1 Page Options
Permalink: hEp ) Mysie arlistearnsd | View Paga W] Shaw page tie
Sho s S ar N Ment
Layout Upoadinset [ IO J72 & B &  Visual Wenu Caption
o : — Page 1
|IZ? B|Z|ms |22« E|E = = |7
HTML T Tag
Fage 1
REyWOrss
MR
Enter Page content here
. H e o 5 N [A5E
Lorem ipsum dolor sit amet, consectetur adipiscing elit. Eiam pk
tellus sit amet congue vulputate, nisi erat iaculis nibh, vitae feug
sapien ante eget mauris. Aenean sollicitudin imperdiet arcu, vita:
dignissim est pasuers id.
Publish
Read more

Previaw Changes
Remember, use the Screen Options to change the options you see on this page.

Layout This is the content layout option you selected on the desktop
(Edit>Content->Content Layout). You cannot change the layout on the web.
If you want to change the layout you have to make the change on the
desktop, and then re-publish your website. Also, the editor only shows you
one section of the layout at a time. The first top section is selected by default
(the border changes to a solid bar). Click on the other sections to select
them and display their contents in the editor.

Note, this option appears only if your content layout consists of at least two
columns.
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Page Options
Show page title

Show as Separator

in Menu

page

Below the Post title is the editor you can use to change your content on the
web. This is the same editor used in Wordpress. The editor has two modes
which you can change from the tabs: Visual — works much like a simple word
processor. HTML — use to enter your content with HTML tags. Across the

top of the editor is a set of icon links you can use to:

e insert media, such as images, video, music, document types (e.g. pdf
files),
e add a google map into your page content,

e add a contact form to your post.

Normally the page title appears as a heading over the content area on your
page. Unselect this option if you do not want the page title to appear on the
page.

The page appears in the horizontal menu bar but does not have an URL
associated with it. That is, when you click on this page in the menu bar, the
browser will not jump to this page. If this page has any child pages, they will

appear as subitems under the page name on the menu bar.

The horizontal menu will only display a relatively small number of menu items
before the menu wraps around on the page. Artisteer only supports a one-
line menu bar. If your menu choices wrap around in the window, you will
need to change your page names and/or the number of pages that appear in
the menu. This option is useful for combining several pages into a group that
is accessible from the menu, using the ‘separator’ page as the group name,

or main menu choice.

Note, this creates an actual page for your website, but the menu bar has no
link to the page so users cannot navigate to the page from the menu bar (i.e.

the name is used just to group a set of submenu items). However, if you
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Keywords

Description

Meta tags

page

include the page in other places such as the vertical menu, there is a link to
the page so remember to exclude the page from the menu source if you do
want this behavior. You can set this option on the desktop (right click on the
page in the page tree > properties>Show in Menu).

HTML Title Tag defines the title of the document.

The title element does several things:

- defines a title in the browser toolbar

- provides a title for the page when it is added to favorites

- defines a title for the page in search-engine results

The page title is the default value.
Your keywords become part of the meta tag, ‘keywords’ in the HTML code for

this page.
<meta name="keywords" content="sepkeyword" />

On the desktop, for pages, you can also define this in the page properties.
You can also define default page tags in your export options
(File=>Export->Export Options).

Your description becomes part of the meta tag, ‘description’ in the HTML

code for this page.

<meta name="description" content="this is my separator page" />

On the desktop, for pages, you can also define this in the page properties.
You can also define default page tags in your export options
(File=>Export->Export Options).

Use this text box to add the HTML code to define additional meta tags you

want included. These are important to the search engine rankings for your

page.
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Status

Visibility

Publish on

page

<meta name="author” content="Bob Smith” />

<meta name="contact” content=bsmith@robertsmith.us />

On the desktop, for pages, you can also define this in the page properties.
You can also define default page tags in your export options
(File=>Export—>Export Options).

Use this to show the status of the changes to your post. If you set the status
to ‘published’, your changes are immediately added to your website. If you
change the status to ‘pending review’, or ‘draft’, your changes are not
published until you change the status back to ‘published’.  The status
indicator can also be used to show you and others if the page needs to be

reviewed before publishing.

If you select the ‘Save as Pending’ button, the page is saved and the status is
either ‘Draft’ or ‘Pending Review'. If you select the ‘Publish’ button, the status

is changed to ‘published’.

You may see the status displayed as scheduled. This means the changes to
the page have been scheduled to be published by Artisteer.net at a future
date and time.

Use this to change the accessibility of your page. Your page can be either

e Public — anyone can view the page.
e Password protected — viewers of your website need to enter a
password before they can view the page.

e Private — only you can view the page.

Use this to backdate your changes to a particular date and time, or schedule

a time when Artisteer.net will apply the changes later. Note, this depends on
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Allow comments

Allow trackbacks
and pingbacks

Page Attributes

Parent

Order

page

the Timezone option in your General settings:

(Options—> Settings—> General->Timezone).

Select this if you want to allow viewers to comment on your page. When this
option is selected, a comment box is added to your page where viewers can
enter comments.

Other blog writers can write articles and include posts on their blogs that
include a reference (link) to a page on your blog. If you set this option,
Artisteer.net will create a special comment on your page which will show
which blogs are linking to your page. This feature depends on your
Discussion  settings  (Options-> Settings—>Discussion—>Default  article
settings), and the CMS where the blog is referencing your article. See

‘trackbacks and pingbacks’ in the glossary for more information.

Assign a parent page if you want this page to be a child. On the navigation
menu, child pages appear as submenu items.
This is the relative order of the page as it appears in the menu bar and in the

page folder on the desktop.
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Set featured image

Slug
Slug

Revisions

page

Pages €
=] Home
= Practices
;:1. Mews
4 |7] References
= Peer Review
= Contacts
= Testimonials

5 = Biography

Posts
= Attorney of the Year
=] Professional Award
=l serving People

The order starts from 0. So in the picture above, the ‘Home’ and ‘Peer
Review' pages both have z-order, 0, while the ‘Practices’ and ‘Contacts’
pages have z-order 1. If you wanted ‘Contacts’ to appear before ‘Peer
Review’ in the menu, and in the page folder on the desktop (picture above),

you would set the ‘Contacts’ order to 0, and the ‘Peer Review’ order to 1.

You can insert a featured image to a page/post. Starting from Artisteer 3.1
featured images for pages appear as featured header images, and featured

images for posts appear as post thumbnails.

Note, featured header images are available only if you publish your theme

from Artisteer 3.1.

Slug is an URL friendly version of the title generated by Artisteer.net. Slugs

are used with Permalinks. E.g. http://mydomain.artisteer.net/my-dog-page
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Comments

Comments

Google Maps

Location Name

Address

Location

Description

Map Width

Map Height

Options

Send Map to Editor

page

Artisteer.net keeps track of the changes you have made to your pages.
Select any one of the revisions to redirect the browser to the revisions page.

From there, you can restore your page back to any previous set of edits.

This is a list of comments, if your page allows comments and viewers have

left comments on your web site for this page.

Enter a name for the location you want displayed on the map (e.g. Statue of
Liberty)

Enter the address location for the map (e.g. 123 anystreet, anycity,
anycountry)

Enter a short description of the location.

Enter the maximum px width for the area of the map on your page. The
default width value is 100% of the parent container.

Enter the maximum px height for the area of the map on your page. The
default height is 400px.

These are options related to how your viewers can interact with the map on
your page. i.e. Enable or disable the zoom options. Change the map view
from street map to satellite view. Allow for additional textboxes which
viewers can use to get directions to, or directions from, a particular location.
Use this to add the map to your page. This will add the shortcode to the
HTML for your page. The shortcode is added wherever your cursor is in the
editor. Note, to remove or change your map, you will need to delete this

code in the editor and then reuse this form to define a new one.
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You can use the editor to add images, video and other media to your pages. You can either add
media to your page using the icons above the editor, or you can add links directly in the HTML. Refer
to the section below on editing posts (Edit Post page) for more information. Also, refer to the ‘Press
This’ tool described below to find out how to include images and video from other websites into your

own.

You can also add images and video to pages from the desktop (Edit>Insert->). The source of any
images or video you add to a page is from a file on your computer, or else from the Artisteer Clip Art
library. In either case, the media becomes part of your Artisteer project and when you publish your
website, the media is uploaded to Artisteer.net and becomes part of the media library and gallery for
the page. The HTML in your content is automatically changed to refer to the media on Artisteer.net
instead of your computer. On the desktop, video media is always added to your page as an
embedded link to the video file on the web. Links to media (e.g. video links) are not included in your

media library or gallery.

Note, for security reasons, you cannot upload Flash files (except for Artisteer’s flash files which you
can include in your header); however, you can add links to video on other websites, or embed the

video in your page. See Options—> Settings—>Media—>Auto-embed for more details.

Use the Google maps icon, “~, to insert a location map into your page. This is the same as adding
the map thru the editor as described above. The attributes you define for the map (e.g. Location

name) are the same.

Use the Contact form icon == to insert a custom contact form to your page. A contact form can be
used to gather information from a viewer, or allow a user to send you feedback, or other comments
without having the information posted on your blog, and without using e-mail directly. When the form

is submitted by a viewer, the information is sent in an e-mail to the author of the page or post, and also
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added to a list of feedback messages on your blog. You can view your feedback messages using the
Feedbacks icon on the ribbon bar (Extras—>Main->Feedbacks).

Adding a contact form to a page is the same as adding a form to a post article. See the Edit Post page

below for more information about creating and using contact forms.
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Use this page to create a new page for your website. The options on this page are the same as

described above for the Edit Page page, except:

Publish

Save Draft Preview

Status; Draft Edit

Visibility: Public Edit

7] Publish immediately Edit

Move to Trash Publizh

Publish

Save Draft The ‘Save Draft’ button saves your page in draft status which means that the
page has not been published yet. If you want the page published right away,
select the ‘Publish’ button.

Status Use this to set the status of the page to either ‘Draft’ or ‘Pending Review'.
This is intended to communicate the status of the page to yourself or others
moderating your content. ‘Draft’ generally means that you anticipate making
changes to the page. ‘Pending Review' means that the page is ready for
publishing but it needs to be reviewed first. If you select the ‘Save Draft’
button, the page is saved in whatever status mode you set. If you select the
‘Publish’ button, the status is updated to ‘published’ and your page is
immediately published to your website. You may see the status displayed as
‘scheduled’. This means you have set a future date and time that you want

Artisteer.net to publish your page.

Visibility Public — the page can be viewed by anyone.

Private — the page can only be viewed by you, other Administrators, or
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immediately

page

Editors (see Options—>Users).

Password protected — To view the page, viewers are challenged with a
password. Only those with the correct password can view the page.

You can use this to set when the page should be published.

If you select the ‘Save Draft’ button, your page is not published. If you select
the ‘Publish’ button, your page is published immediately with the current date

and time shown.

You can change the date and time to backdate the page but also publish it
immediately, or you can enter a future date and time and then Artisteer.net
will schedule and then publish your page later. You must use the ‘publish’
button (not ‘save as draft’)) to have the page published on the date you
entered. Note, this depends on the Timezone option in your General settings

(Options—> Settings—> General-> Timezone).
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When you create a new Artisteer project on the desktop, your web pages always include, by default, a
horizontal menu, a sidebar and a vertical menu in the sidebar area. You can remove one or both by
changing the layout of your page (Layout->Design Layout->one of the options with no horizontal

menu, or Layout->Columns—>0One column).

Both menus, by default, use the Pages of your website as the source of the menu. That is, when you
add pages, the page title and link is added to the menu. On the desktop, you can change which pages
are included in the menus, but you cannot change the links, change the menu source, or create a

custom menu. If you want to do any one of these, you need to use the Menus page in Artisteer.net.

Both menus have, by default, your webpages as the source of the menu. If you want to change the
source to your blog -categories, change the source settings in your theme options
(Extras>Main>Theme). See ‘Default Horizontal Menu Source’, and ‘Default Vertical Menu Source’

below.

If you want to create a custom menu, use the Menus page. Before you can begin, you need to create
a new blank menu. On the Menus page (Home->Menus), enter a menu name in the Menu Name field,

and select the ‘create menu’ button.

On the left side of the page are your Theme Locations. The caption for this dialog says “Your theme
supports 2 menus.” You can have more than 2 menus on your pages (using widgets), but what this
means is that Artisteer only supports one horizontal menu bar and one vertical menu. On this page,
‘Primary Menu’ refers to the horizontal menu, and ‘Secondary Menu’ refers to the vertical menu. You
use this page to create a custom menu, and then assign it in the Theme Locations to either the
horizontal menu, or the vertical menu. Both the horizontal and vertical menu may refer to the same
menu. (Note, once set, they override any settings in your Theme Options, like ‘Default Horizontal

Menu Source’).

Below the Theme Locations are your Custom Links, Pages, and Categories. Use these panels to add

menu items to your menu.
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Once you have added menu items to your menu, you can use drag&drop on the menu item list to
change the order that the menu items will appear on the menu. You can also select each item in the
list and edit the item using the button next to each menu choice. The edit panel has more attributes

you can define about each choice (explained below).

Menu Name
+ Click on this to create new menus.
Automatically add Normally when you create new pages, the top-level pages are added by
new top-level default to the menu. When you create a custom menu, the menu choices are
pages created by you as either custom items and links, or a subset of pages and
blog categories. Select this if you want Artisteer to also add menu items to

your custom menu automatically when you create top-level pages.

Theme Locations
Primary Menu This refers to the horizontal menu bar. Use the drop down menu to select the

menu you want to use, or leave unselected to use the default menu.

Secondary Menu  This refers to the vertical menu bar. Use the drop down menu to select the

menu you want to use, or leave unselected to use the default menu.

Use this to create a custom menu.

Custom Links
URL Enter a valid URL address link to use for the menu item.

Label Enter the text you want to appear on the menu.

Pages

Use this to select the page links you want to include in the menu.
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Categories
If you have created blog categories for your posts, use this to select the
categories you want to include in the menu. Clicking on this choice will have
the same result as clicking on a ‘category’ link in one of your posts.

Post Tags

If you have created any post tags for your blog, use this to select the tags you
want to include in the menu. Clicking on a tag choice in the menu will have

the same result as clicking on a ‘tag’ link in one of your posts.

As mentioned before, after you have added your choices to the menu, you can reorder the choices

and also edit and add more attributes about each item.

Contact
URL
http://www.mysite.artisteer.net/new-contact-page-2
Mavigation Label Title Attribute
Contact this is my contact page
Link Target C355 Classes (optional)
Same window or tab El

Link Relaticnship

Description
this is my contact page description

The description will be displayed in the menu ifthe current theme
supports it

Remove | Cancel
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Navigation Label

Link Target

Link Relationship

Title Attribute

CSS Classes

page

This is the URL you want to redirect the browser to when the user selects this

choice.

Text that appears for this item in the menu.

Clicking on this menu choice redirects the browser to a new window or tab, or
the current window or tab.

If you are linking to someone else’s website, you specify your relationship to
them. This is called XFN. XFN stands for XHTML Friends Network. The text
you enter here is arbitrary. You can find examples of typical entries on the
New Link page.

This is the alternate text that appears below the menu when you hover the
mouse over the menu choice.

Specify the CSS class for the menu item and define custom styles for this

CSS class in Artisteer>Export Options> CSS Options.
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When you use a contact form on your page or post, the information you get from viewers is collected
and sent by e-mail to the author of the page or post. The information collected is also added as a
feedback message to your blog. The feedback you collect from users becomes part of your blog but
not displayed on your website like viewer comments. (Note, although this is referred to as the
Feedbacks page, the messages collected, sent and displayed on the page are not necessarily
feedback comments from your viewers, since custom contact forms can be used for many different
functions, such as polling users on their preferences, or getting personal data such as e-malil

addresses.)

You can use the Feedback page to monitor and manage these messages. As an administrator, you
can view all the feedback messages sent even if you are not the author of the post. You can filter the
list by date, or search on the comment text, author, e-mail address, IP address (which is collected
automatically), or any custom fields you have added to the contact form (since they are collected as
text and appended to any comments). Typically, a contact form will ask for a name, an e-malil
address, and comment. All of these fields are collected and included in the feedback list; however,
you can modify the contact form to ask for anything you want. Any custom fields you add to the form

are collected and appended to the ‘comment’ text.

Use this page for managing the messages. If you decide to delete a particular feedback message,

there are two edit options you can select in the editor: move to spam, or move to the trash bin.

See the Edit Post page below for more information about how to use contact forms and add them to

your page or post.
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From b Message Date

No feedback found

From Meszage Date

Bulk Actions [=] | Apply
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Use this page to manage your Post articles. Your ability to create and edit posts depends on your

user role (Options—>Users).

There are two views: List, and Excerpt. You can select which view you want by selecting one of the

icons to the right of the filter, l—_v
List view — displays just the post titles.

Excerpt view — displays the post titles, and then a partial excerpt of the post article underneath

each title.

Use the ‘Search Posts’ search box to find Post articles by their title or their content. You can also use
the ‘filter’ on this page to filter the posts shown by either a date range, by category, or by tag (by

clicking on one of the tag links next to an article).

Each post on your website has its own webpage. Your frontend, or blog posts page, displays the
posts on your page, but users can navigate to other posts using links which are displayed alongside
your post (e.g. author, category, or tag links), or redirect to a page showing you all the comments that
have been left for a post. You define which links appear along with your post using the desktop
(Content->Metadata—>Icons).

When you hover the cursor over any post title, you should notice that a menu appears underneath the
title (‘edit’ | ‘quick edit’ | ‘trash’ | ‘view’). Edit and Quick Edit are described below. View lets you see
what your post page currently looks like on your website. The Trash option is used to remove posts
you no longer want. Above the list of your posts, you should see a ‘Trash’ link. This link only appears
if you have posts in your trash bin. If you later want to restore one of your posts, click on this link,
move the cursor over the post you want to restore and select the Restore link that appears below the
post name. However, if you Permanently Delete the post, or the trash bin has been emptied, you

cannot restore the post.
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Use quick edit from the page menu to quickly configure common attributes of your posts. Always use

the Update button to apply your changes, otherwise your edits will be discarded.

Bulk Actions [=] | Apply

Title
QUICK EDIT
Title Pngtl

Slug post

Date Sep [=] |28 |,

Password

Cancel

Title

Slug

Date

Categories

Post Tags

Show all dates El View all categories EI Fitter G

Author Categories Tags [ Date
Categories [more] Post Tags

dogs
¥| Uncategorized

2011 (@ | 00| |3 V| Allow Comments [¥| Allow Pings

—OR— Private Status  Published [=] Make this post sticky

Update

Short description of your post. ‘Title’ is the text that appears at the top of
your post page, and on pages listing your posts (e.g. frontpage, or blogpost
page).

Slug is an URL friendly version of the title generated by Artisteer.net. Slugs
are used with Permalinks. E.g. http://mydomain.artisteer.net/my-dog-fred-
article

Use this to either backdate the date and time the post was published, or
schedule a date and time when Artisteer.net will apply your changes later.
Make sure to set the status to published, and select the ‘Update’ button.
Note, this depends on the Timezone option in your General settings
(Options—> Settings—> General-> Timezone).

Use this to assign your posts to categories. If you have added the Category
link to your content on the desktop, your viewers can click on a category link
next to the post on your website to display all the posts in that category
(Content->Metadata—->Icons).

You can find more information below about blog categories in the section

describing the Categories page.

Use this to assign tags to your posts. If you have added the Tags link to your
content on the desktop (Content->Metadata—>Icons), your viewers can click
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Allow Pings

Status

Make this post
sticky

Password or

Private

page

on a tag link next to the post on your website to display all the posts with the

selected tag.

You can find more information below about tags in the section describing the
Tags page.

Select this if you want to allow viewers to comment on your posts. Note, this
overrides the ‘comments’ setting in your Discussion options
(Options—> Settings—> Discussion—>Default Article Settings).

This is the same as the option, ‘Allow trackbacks and pingbacks’, on the Edit
Post page (see below).

Use this to assign a status to the changes you have made. If you do not
want the changes to be applied and published right away, set the status to
‘Pending Review’ or ‘Draft’. These status codes are used to describe the
state of your changes. ‘Draft’ means you anticipate more changes. ‘Pending
Review’' tells other Editors or Administrators that the post is ready for
publication, pending moderation. If you want to publish your changes
immediately, set the status to ‘published’. When you select the ‘Update’

button, your post is published depending on however way status is set.

You might see the status displayed as ‘scheduled’. This means that you
have scheduled the post to be published at some future date and time.

Your frontpage, or blogposts page, displays the articles that have been
posted to your website, however only a certain number of posts will appear
on this page (see Options—> Settings>Reading—>Blog pages show at most).
Older posts are shown on separate pages, accessible from links on the
bottom of the page. Select this option if you want the post to always appear
at the top of the post list. Depending on the number of ‘sticky’ posts you

have, this normally means the post is always displayed on the frontpage.

Note, this option is only available under ‘quick edit’.
Select ‘private’ if you want the post to be visible only to you (e.g.
administrator). Enter a password, if you want the post visible only to viewers

who supply the correct password.
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Use the Edit Post page to edit the full range of features and attributes of your posts. Remember, the
Screen Options determine what is available to edit on this page. Also, always use the Publish pane on

this page to apply your changes, otherwise your edits will be discarded.

Edit Post

MyPost
Permalink: http// mysite.artisteer.net/201 1/28/post/ Edit View Post Get Shortlink
L.I;:IIDEH:I.I’Ir1se|:*E I O[m a2 B E HTML
b i | link | b-quote &e ins |img| ul | ol li | code more | lookup  closetags
Editor Below the Post title is the editor you can use to change your content on the

web. This is the same editor used in Wordpress. The editor has two modes
which you can change from the tabs: Visual — works much like a simple word
processor. HTML — use to enter your content with HTML tags. Across the

top of the editor is a set of icon links you can use to:

e insert media, such as images, video, music, document types (e.g. pdf
files),
e add a google map into your page content,

e add a contact form to your post.

Get Shortlink Use this to create a shortened version of the Permalink URL.

Most of your pages on your website are indexed by a number. The URL is

hidden from you because Artisteer.net uses Permalinks (see the Permalinks
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Slug

Google Maps
Location Name

Address

Location
Description
Map Width
Map Height

Options

Send Map to Editor

page

page below for more information). Permalinks may become relatively long
depending on how they are formatted. Long URL addresses are not always
useful, depending on the context where they are used. There may be some
instances where you need to use a short URL. For instance, if you are using
Twitter, you are limited to URLs of a certain length. You may also find a
Shortlink useful if you are providing the URL as text instead of a hyperlink,
such as in an email message, where the text may be subject to reformatting,

such as injecting line breaks in long lines.

Slug is an URL friendly version of the title generated by Artisteer.net. Slugs
are used with Permalinks. E.g. http://mydomain.artisteer.net/my-dog-fred-

article

Enter a name for the location you want displayed on the map.

Enter the address location for the map (e.g. 123 anystreet, anycity,

anycountry)

Enter a short description of the location.

Enter the maximum px width for the area of the map on your post.

Enter the maximum px height for the area of the map on your post.

These are options related to how your viewers can interact with the map on
your post. i.e Enable or disable the zoom options. Change the map view
from street map to satellite view. Allow for additional textboxes which
viewers can use to get directions to, or directions from, a particular location.
Use this to add the map to your post. This will add the shortcode to the
HTML for your post. The shortcode is added wherever your cursor is in the

editor. Note, to remove or change your map, you will need to delete this
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code in the editor and then reuse this form to define a new one.

Comments
Comments This is a list of comments, if your post allows comments, and viewers have

left comments on your web site for this post.

Every time you edit your post, you should use this panel to update your post with the Update button. If

you do not update your post, your changes will be lost.

Publish
Status Use this to show the status of the changes to your post. If you set the status
to published, your changes are immediately added to your website. If you
change the status to ‘pending review’, or ‘draft’, your changes are not
published until you change the status back to ‘published’. The status
indicator can also be used to show you and others if the post needs to be
reviewed before publishing.

Visibility Use this to change the accessibility of your post. Your post can be either

e Public — anyone can view the post.
e Password protected — viewers of your website need to enter a

password before they can view the post.

Private — only you can view the post.
Published on This is the publishing date that appears alongside your post on your website.
Use the ‘edit’ link to change this date and time.

Discussion
Allow comments  Select this if you want to allow viewers to comment on your post. When this
option is selected, a comment box is added to your post where viewers can

enter comments.  Note, your Discussion settings control who can leave
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and pingbacks

Author
Author

Categories

Categories

Send Trackbacks

Send trackbacks to

page

comments and how your comments are moderated:

(Options—> Settings-> Discussion).

Other blog writers can write articles and include posts on their blogs that
include a reference (link) to a post on your blog. If you set this option,
Artisteer.net will create a special comment on your post which will show
which blogs are linking to it. This feature depends on this setting, your
Discussion  settings  (Options—> Settings—>Discussion—>Default  article
settings), and the CMS where the blog is referencing your article. See

‘trackbacks and pingbacks’ in the glossary for more information.

If you have more than one user invited to your website (Options>Users),
choose the user to be the designated author. If you have added Author to
your posts on the desktop (Content->Metadata—>Icons), the author will be
listed alongside the post so viewers can click on the link to display other

articles created by the author.

Use this to assign your posts to categories. If you have added the Category
link to your content on the desktop category (Content->Metadata—>Icons),
your viewers can click on a category link next to the post on your website to

display all the posts in that category.

You can find more information below about blog categories in the section

describing the Categories page.

Enter the trackback URL for the blog page or post you want to link to.
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Trackbacks are used with older blogs that do not support pingbacks.

If you want to notify another blog that your post article refers to a page or
post on the other blog, you enter a special URL here that is used by
Artisteer.net to send the notification to the other site. The URL that you enter
here is part of the content on the other blog. The hyperlink may be called
anything but normally on older blogs that support trackback you will find a link
called ‘Trackback URL’ on the page you want to reference. Also note, some
systems use the permalink to the page with ‘trackback’ tag tacked to the

address: e.g. http://www.mysite.net/2011/1004/my-dog-fred/trackback/

Artisteer.net websites support pingbacks, not trackbacks. If you want to link
to another Artisteer.net site, include the link in your post content; do not put
the link in the ‘send trackbacks to’ field. If the other site accepts pingbacks
(e.g. an Artisteer.net website, or wordpress site, and the site is configured to
allow pingback to the post), the site will respond to the ping and a comment

will usually be posted to the other blog.

You can also find a description of “Trackbacks and Pingbacks” in the

glossary.

Use this to assign tags to your posts. If you have added the Tags link to your
content on the desktop (Content->Metadata—>Ilcons), your viewers can click
on a tag link next to the post on your website to display all the posts with the

selected tag.

Note, separate the tags with commas, otherwise all words you enter here will

be treated as one tag.

You can find more information below about tags in the section describing the

Tags page.
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When your posts are listed on your frontpage, or blogpost page, normally the
full-text of the post is displayed on the page. You can override this by

providing a short excerpt here which will be displayed instead.

Note, you can also use the ‘more’ tag (from the editor menu bar in HTML
mode) in your article text. Just put the tag somewhere in your text. All of the

text up to where your tag appears will be included in the excerpt.

Also, in your Theme options you can have Artisteer.net generate an excerpt

automatically, however entering an excerpt here overrides this option.

Excerpts are also used in RSS feeds (Options—> Settings—>Reading—>For

each article in a feed, show.

Featured Image

Set

On your frontpage, or blogpost page, you can optionally display an image next to your

featured post title.

image

Use this to set the image you want to display.

The dialog displayed is the same one you used to insert images into your post, except
instead of selecting the ‘Insert into Post’ button at the bottom, select ‘Use as featured
image’. The featured image is displayed as a thumbnail next to the post title, therefore
most of the fields (e.g. description, size, alignment, etc.) on this form are for your own
reference unless you intend to insert the image elsewhere in your pages and posts.
See the section, ‘Inserting Media in your Pages or Posts’ for more information about

these fields and inserting images in your pages or posts.

Note, after you have set a featured image, make sure that you update your post on the

Edit post page (‘Update’ button).
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Edit Image

Title

Alternate Text

Caption

Description

Link URL

Alignment

Size

Revisions

page

File name: iStock_000002624322Medium.png
File type: image/png
Upload date: September 28, 2011

Dimensions: 68 = 52

iStock_000002624322Medium

Alt text for the image, e.g. “The Mona Liza®

http:// my=ite16_artisteer.net/files/2011/09/1Stock_000002624322Medium.png

MNone File URL Post URL
Enter a link URL or click above for presets.

@ = Mone @%=left @ = Center & ==Right
Thumbnail Medium Large @ Full Size
(B3 x 52)
Insert into Post Use as featured image Delete

This is a list of the revisions you have made to the post. You can use these

links to compare revisions or restore the post to a previous state.

You can use the editor to add images, video and other media to your posts. You can either add media

to your post using the icons above the editor, or you can add links, or embed media directly in the

HTML. Also, refer to the ‘Press This’ tool described below to find out how to add images and video

from other websites into your own.
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You can also add images and video to posts from the desktop (Edit->Insert->). The source of any
images or video you add to a post is from a file on your computer, or else from the Artisteer Clip Art
library. In either case, the media becomes part of your Artisteer project and when you publish your
website, the media is uploaded to Artisteer.net and becomes part of the media library and gallery for
the post. The HTML in your content is automatically changed to refer to the media on Artisteer.net
instead of your computer. On the desktop, video media is always added to your post as an embedded
link to the video file on the web. Links to media (e.g. video links) are not included in your media library

or gallery.

Note, for security reasons, you cannot upload Flash files (except for Artisteer’s flash files which you
can include in your header); however, you can add links to video on other websites, or embed the

video in your page. See Options-> Settings—->Media—> Auto-embed for more information.

Across the top of the editor is a list of icons for adding media to your post:

Upload/insert |l 4 JJ j = % ==l

All of these except for the last two can be used to upload media from your computer, link to media on
the web, or add media to your website from your personal media library (which is actually a library of
all the media you have uploaded from your computer so far). The last two icons are for adding a

google map (location map), and adding a custom contact form.

When you click on any one of the media icons, you are redirected to a dialog to choose the source of
the media file. It doesn’t matter which icon you select, the dialog is generally the same for all types.

This is an example of uploading a PDF file:
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Add an Image

From Computer | From URL Gallery (3) MWedia Library

Add media files from your computer

Choose files to upload Select Files

Maximum upload file size: 5MB

Y¥ou are using the Flash uploader. Problems? Try the Browser uploader instead.

85 DESN Upinaced, you can aod Dhes and CesCcriplions.

File name: Artisteer3-User-Manuali . pdf

= File type: application/pdf
% Upload date: October 5, 2011
Title Artisteer3 User Manual
Caption
Description
P
Link URL http://mysite| artisteer net/files/2011/10/Artisteer3-User-Manual. pdf

Mone File URL Post URL
Enter a link URL or click above for presets.

Insert into Post | Delete

Save all changes

The attributes (e.g. Link URL) you define varies depending on the type of media you want to include.

The first tab is always ‘From Computer’. Use this tab to upload media files to Artisteer.net and add
them to your media library. After the file is uploaded, the file is automatically added to the media
library and the post's gallery. Use the ‘Insert into Post’ button to add the media to your post,

otherwise, the file will be uploaded but will not appear in your post content. You can also upload files
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using the New Media page, but they do not automatically get attached to the post (added to the

gallery) until you either attach them from the media library, or include them later in your post.

After the file is uploaded, you can add attributes which determine how the media appears on the post
and what happens when your viewers click on the media. In the example above, the title is what
appears to your viewers as the hyperlink on your post. You want to select a title that is self-descriptive
for your viewers, and also for search engines. The caption field in this example does nothing for the
hyperlink to your document, but if this were an image, the caption would add text underneath your

image on the post. The attributes for each type of media are different.

Use the ‘From URL’ tab to use a web address as the source of the media. Use this tab to collect
media resources on the web instead of uploading the files to Artisteer.net. Remember, you have quite
a bit of space reserved for your website on Artisteer.net, but the space is limited. When you link to
media on the web, instead of uploading to your website, you are not using any space. You have to
balance your choice of location based on the availability of the media on the web, and the time
involved to render your web page in your viewer's browser since these images are retrieved on

demand from the web when the page is loaded.

Except for image media, Artisteer.net always inserts a hyperlink to the media in your page or post.
You enter an URL to the media (e.g. video, document, etc.), and a Title which is how your link will

appear on the page.

Add Video

From Computer | From URL | Media Library

Add media file from URL

Video URL *

Title '

Insert into Post
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For an image, the attributes are similar to adding an image file from your computer (e.g. Title) except
you define an URL and a Title.

Add an Image

From Computer | From LIREL | Gallery (¥) WMedia Library

Add media file from URL

Insert an image from anothe

Image URL E
Image Title

Alternate Text

Alt text for the image, e.g. “The Mona Lisa®

Image Caption

Alignment @ = None @ ==Lleft © = Center @ ==Right

Link Image To:

MNone Link to image

Enter a link URL or click above for presets.

The image is embedded and displayed within your page (i.e. not a hyperlink). ‘Title’ is what appears
on the page when you hover the mouse over the image. ‘Alignment’ defines how the image will be
aligned with other text. ‘Link Image To’ defines what happens when a user clicks on the image.
Clicking the ‘None’ button just clears the text box. If you do not want the image to link to another page,
leave this blank. Clicking the ‘Link to image’ button copies the Image URL in the first text field to this
box. Clicking on the image on your page will open a new page on just the image using the URL

address of the original source (same as File URL).

Use the ‘Media Library’ tab to add images, sound, video, etc., to your posts using the media files you
have previously uploaded into your library. Use the ‘Show’ button to display the attributes of the
media you can define, e.g. Title, and the ‘Insert into Post’ button to add media to your content. Use
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the ‘Save all changes’ button to keep any changes you have made to the attributes you have defined

for the media.

Add Video
From Computer From URL Gallery (5) | Media Library
All Types | Images Audio Video

Show all dates [v| | Fiter »

ﬁ Flick&nimation

Save all changes

The ‘Gallery’ tab appears when you select the gallery icon ==' or the image icon - in the editor. A
dialog will appear allowing you to insert images from your computer (Browse>Upload), insert using an
URL (enter URL and other settings)), or insert image from the Media Library (Add to Gallery). Note, the
images removed from the gallery are not removed from the media library. You also should have the

Adobe Flash Player installed on your browser to be able to select several files at a time.

Add Gallery X

From Computer From URL | Gallery (0) | Media Library

Mo pictures found in the gallery.
Please add media files from the Computer, the URL or the Media Library

The gallery may be useful in several ways:

- if you want to organize your images based on your pages or posts, and/or you frequently
change media in your content.

- if you let Artisteer.net automatically generate thumbnails for the featured image associated
with your post. If you do not specify a particular image, Artisteer will select the first one in
the gallery (Extras>Main—->Theme Options>Post Thumbnails).

- if you use the LightBox plugin to display your media. For more details about Lightbox, see
Options—> Settings—> Lightbox.
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- if you want to include a photo image gallery in your page or post, you can use the post editor
to insert a [gallery] shortcode into your content.

following options will appear at the bottom of the dialog.

page

available if you have more than one media file attached to the post:

Gallery Settings

Order
images
by:
Order

Gallery

columns

Insert

Gallery

Update
gallery

settings

When you are adding media to your page or post and you click on the Insert into Post button,
Artisteer.net inserts a hyperlink to your media in the editor depending on wherever the cursor is

Use this to set the order criteria that the thumbnail images appear in your

post. e.g. sort by menu order, title, date and time, or random.

Use this to set the sort order using the criteria above. E.g. sort on names in
ascending order

If you include this in your page or post, use this to determine how many
columns your photo gallery will be arranged on the page. e.g. 3 columns
means you have a table with 3 columns and X number of rows depending on
the number of items in your gallery.

Use this to insert a [gallery] shortcode in your post. This option only appears
when the editor is in HTML mode. When you select this option, Artisteer.net
injects the shortcode [gallery] into your HTML source wherever your cursor is

positioned in the code.

There are other options you can elect to use by modifying the shortcode.

See the following link for more details:

http://en.support.wordpress.com/images/gallery/

Use this to update the gallery settings for a photo gallery you have already
included in your post (e.g. change the number of gallery columns). This

option only appears when the editor is in Visual mode.
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located (note, if you are editing in HTML modem, this could ruin your code conformance to HTML if the
cursor is in the wrong place). Images are always displayed embedded in your blog page. Other types
of media appear as hyperlinks. As mentioned before, you cannot upload Flash files to Artisteer.net,
but you can embed Flash files, as well as other types of video files from the web (except for Artisteer’s
flash files which you can include in your header). See Options—> Settings—>Media—>Auto-embed for
more details. (Note, on the desktop, you can insert your own images in your post, or select images
from the clipart gallery. When you publish your project, these are uploaded to Artisteer.net. You
cannot insert videos in your project on the desktop, but you can embed videos from other websites. If
you have your own video, you should add it to your media library on Artisteer.net, and then embed the

video from your own website).

From whatever source you use (computer, web, or media library), use the Insert into Post button to
add the media to your page or post. This button inserts the HTML code for your image, video, etc.,
into the editor wherever your cursor is located. As mentioned previously, before you insert the media,
there are certain attributes you can define to determine the appearance and interaction with the media
on your page. The attributes vary depending on the type of media you are including. Note, if you are
using the Gallery or Media Library, you need to use the Show button to display these attributes, along
with the Insert into Post button. If you have a Gallery attached to your post, the Actions box can be
used to reorder the way the images are displayed on this page in the administrator, and also how they

are displayed in your post ( if you inserted a gallery in the post).

Image Files
Title Enter a title that will identify this file in the media library.

Alternate Text For an image on your page or post, this is the text that appears instead of
the image when the browser setting that blocks images is enabled. The alt
text also appears when a viewer hovers the cursor over the image on the
page.

Description Enter a description that describes the file. The Media Library page

includes a search box that you can use to search by description. If you
use a Post URL, this is the text that will appear on the special blog page
for this file. If you do not use a Post URL, and this page is not accessible
directly to your viewers, the description is still important to search engines

since this page is still part of your website.
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Alignment

Size
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The Link URL defines what happens when users click on the image:

None — The image is not clickable.

File URL — When you click on the image, the current page, or tab, in the
browser displays a full-sized version of the image. The URL in your

browser’s address bar refers to the image file location on Artisteer.net.

Post URL — The image is treated as an attachment to the post. When you
click on the image, a new blog page is displayed with just the image by
itself, the image title and the description. If you click on the image on this
page, it opens a new page on the actual file (same as File URL).

This is the placement of the image relative to any text you already have in
your post.

The size of the image as it will appear in your page or post. The
dimensions and how the picture appears on your page or post depend on
the original image size. Your media settings also determine the maximum

dimensions you can use (Options—> Settings—>Media).

Audio, Video and Document Files

Title

Caption

Description

Link URL

This is the text that appears for the file in your page or post. A hyperlink is
created to open the file based on your Link URL setting below.

This is for your own reference.

Enter a description that describes the file. The Media Library page
includes a search box that you can use to search by description. If you
use a Post URL, this is the text that will appear on the special blog page
for this file. If you do not use a Post URL, and this page is not accessible
directly to your viewers, the description is still important to search engines
since this page is still part of your website.

The Link URL defines what happens when users click on the file.

artisteer.net | page 69



page

None — This just inserts your Title as text in your page or post, therefore
this has very little usefulness since your users cannot select, play, or open
the file.

File URL — This opens a new page on the media file. Depending on how
your browser is configured, this may or may not play, or open the file. For
example, if you are including a PDF file, you need to have a PDF reader
(i.e. Adobe Reader) installed to open and view the file when you click on
the link. If you do not have a browser plugin to handle the media, the

browser will attempt to download the media.

Post URL — Every media file has its own blog page. The page is
displayed with the Title you defined, and an attachment hyperlink

underneath to the actual file, followed by the description you added.

Use the Google maps icon, ! *-, to insert a location map into your post. This is the same as adding
the map thru the editor as described above under Edit post (if enabled from the Screen options). The

attributes you define for the map (e.g. Location name) are the same.

Use the Contact form icon “=| to insert a custom contact form to your post. A contact form can be
used to gather information from a viewer, or allow a user to send you feedback, or other comments
without having the information posted on your blog, and without using e-mail directly. When the form
is submitted by a viewer, the information is sent in an e-mail to the author of the post, and added to a
list of feedback messages for your blog. You can view your feedback messages using the Feedbacks

icon on the ribbon bar.

A contact form can be useful in many ways. For instance, typically, most websites have a contact
page which lists how users can contact you. Typically these sites, especially large corporate sites,
post an e-mail address but due to the large volume of traffic, they often do not have the resources to

sort out and process every receipt. A site may have different pages and contact forms so user

artisteer.net | page 70



page

communication is routed to different e-mail addresses according to the type of request or feedback.
For example, you might use one contact form to allow users to ask questions about a page, post, or
your website, and another contact form to collect personal data or preferences, and perhaps another
form to get feedback. How many contact forms you need, what data they collect, and how the
feedback is routed, is entirely up to you.

When the user submits a contact form, all of the text information on the form is converted to a
comment and sent to the author of the post, unless you change the e-mail notification in the form
options. If you have custom fields, like radio buttons, the option label is used as the text. For
example, if the label for the first radio button is ‘Yes’, and this option is selected, the text in the

comment for this field will be “Yes”.

To add a form, click on the contact icon above the ribbon bar:

Edit Post
Feedback post

Permalink: hitp://nemo.artisteer.net/2011/11/02/feedback-post/ | Edit

Upload/insert | E:E Py j = ’.@

b i link | b-quote | del | ins | img | ul | ol li

This displays a dialog for the default contact form. The typical form asks for name, e-mail, etc., but
you can delete these fields and/or add custom fields of your own. When you are done editing the
form, select the ‘Add this form to my post’ button. This will generate and insert the HTML code (as
shortcode) for your form wherever your cursor is located in the post. If you later want to make
changes, click on the contact icon again, and the existing contact form in the editor will be loaded into

the dialog. To remove the contact form, you need to delete the shortcode in the editor.
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The icon next to each field is used to delete the field. Use the ‘Add a new field’ button at the

bottom of the form to add custom fields to your form:

CIETET
Label This is the text that appears above the field on the form.
Field Type The type of control on the form (e.g. text, radio button, dropdown). If you

select dropdown, or radio, there are other options displayed on this dialog to
allow you to define each option on the dropdown or radio button list. When
the user selects an option, the option label becomes the text returned in the
comment.

Required Should the field be required or not. Users will not be able to submit the

contact form until all required fields have been entered.

Above each field are two links that appear when you hover the cursor over the field:
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Website move  edi

|

Website — edit

The Move option lets you rearrange the order that the fields will appear in the form. You can also use

drag&drop to rearrange fields. The Edit option lets you change the field options:

.....

........

When a user submits the feedback form, the message is emailed to the author of the page or post.

Use the Email Notifications tab to change the default notification:

Erded gt il Sl

Whn ihasis the usject i et

Enter new email  The default is the post authors e-mail address (Options—>Users—>Profile).
address Change this to redirect the message. For example, you might use contact
forms for different purposes, such as submitting questions, versus collecting

personal data, and use different e-mail addresses for each form.
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What should the  Change the subject line in the message. This may be useful if you have an

subject line be e-mail service, or plugin that can manage messages by subject.
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Use this page to create a new post for your website. The options are the same as the Edit Post page,

except:

Publish
Save Draft, Publish The ‘Save Draft’ button saves your post in draft status which means that the
post has not been published yet. If you want the post published right away,
select the ‘Publish’ button.
Status Use this to set the status of the post to either ‘Draft’ or ‘Pending Review'.
This is intended to communicate the status of the post to yourself or others
moderating your posts. ‘Draft’ generally means that you anticipate making
changes to the post. ‘Pending Review' means that the post is ready for
publishing but it needs to be reviewed first. If you select the ‘Save Draft’
button, the post is saved in whatever status mode you set. If you select the
‘Publish’ button, the status is updated to ‘published’ and your post is
immediately published to your website. You may see the status displayed as
‘scheduled’. This means you have set a future date and time that you want

Artisteer.net to publish your post.

Visibility Public — the post can be viewed by anyone.

Private — the post can only be viewed by you, other Administrators, or Editors
(see Options—>Users).

Password protected — To view the post, viewers are challenged with a

password. Only those with the correct password can view the post.

Stick this post to the front - Same as ‘make this post sticky’ option on the
Quick Edit panel. See quick editing posts above. The post is made ‘sticky’
meaning it is listed before any other posts. Depending on how many ‘sticky’
posts you have, this usually ensures that the post always appears on your
frontpage, or blogpost page.
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You can use this to set when the post should be published.

If you select the ‘Save Draft’ button, your post is not published. If you select
the ‘Publish’ button, your post is published immediately with the current date

and time shown.

You can change the date and time to backdate the post but also publish it
immediately, or you can enter a future date and time and then Artisteer.net
will schedule and then publish your post later. You must use the ‘publish’
button (not ‘save as draft’) to have the post published on the date you
entered. Note, this depends on the Timezone option in your General settings
(Options—> Settings—> General-> Timezone).
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‘Categories’ are a set of words you choose to classify your posts.

page

The words you choose for

‘categories’ are typically arranged hierarchically. For example, you might have a category about

‘dogs’, and subcategories called ‘terriers’ and ‘shepards’, and possibly sub classifications for ‘terriers’

and ‘shepards’, and so on. If you have a post article about ‘dogs’ in general, you might assign the post

to the ‘dogs’ category. Similarly, if the article was specifically about ‘terriers’, you might assign the

article to ‘terriers’ and ‘dogs’. Using ‘categories’ to classify your posts makes it easier for your viewers

to find posts related to topics that interest them.

You can add new categories to your website with the Categories page. When you create a new Post,

you choose which of these categories should be associated with the article. You can also create new

categories on the Edit Post page, then go to this page later and complete the description of the

category.

Add New Category

Name

Parent

Description

Add New Category

Use this as the title for your category. If you have added a link to categories
on the desktop (Content->Metadata—>Icons), this is the title that appears
alongside your post, if you have added this post to the category. This is also
the title of the page your viewers are redirected to when they click on the
category link.

Use this to organize your categories in a hierarchy.

Enter a short description of the category. The description appears
underneath the category title on the page your viewers are redirected to
when they click on the category link.

Click this button to add your category, otherwise your changes will be

discarded.
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‘Tags’ are a set of words you choose to associate key ideas or topics related to the content of your
posts. ‘Tags’ make it easier for viewers to find your website, and your post articles, using search
engines. The words you choose for ‘tags’ are not organized in any way, though they could also be the
same words you used to define your categories, and they may be very general, or very specific. For
example, suppose you have a blog about ‘automobile repair. Some of your articles might be about
engines and so the tags may go from very general to very specific depending on the article, like
‘engines’, ‘toyota’, ‘4-cylinder’, ‘1.6 liter’, ‘'DOHC’, ‘2007’.

Categories are often defined as a hierarchy. Tags however are not defined in a hierarchy. They are
usually used as search mnemonics. For example, you might have an article about an ‘Airdale terrier’.
Instead of creating a separate subcategory about ‘Airdales’, you might choose to include ‘Airdale’ as a
tag associated with your post so your viewers could find other articles about this particular breed. If
you add a ‘Tag Cloud’ widget to your pages, your tags are arranged in a display on your page which

makes it easy for users to navigate articles based on the tag words associated with your pages.

Tags are not the same as metadata keywords but they are very important to how search engines rank
the pages of your blog. Keywords are included in the HTML source for your pages and they help
drive traffic to your website, but they are not visible to your viewers, while tags are special words
associated with your posts which aid viewers navigating your website. However, both are used by

search engines to direct viewers to your blog.

You can add new tags to your website with the Tags page. When you create a new Post, you choose
which of these tags should be associated with the article. You can also create new tags on the Edit

Post page, then go to this page later and complete the description of the tag.

Add New Tag

Name Use this as the title for your tag. If you have added a link to tags on the
desktop (Content->Metadata—>1cons), this is the title that appears alongside

your post, if you have added this tag to your post. This is also the title of the
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Add New Tag
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page your viewers are redirected to when they click on the tag link.

Note, when you create a post, you can also enter a set of tags that are
created alongside your post. You can enter a comma-separated list of words
for the tag and Artisteer.net will create a tag for each word. However, on this
page you are creating a single tag; do not use commas here unless you want
the commas included in the tag title.

Enter a short description of the tag. The description is used to explain your

tag on Artisteer.net (e.g. Tags page), but it is not included in your website.

Click this button to add your tag, otherwise your changes will be discarded.
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Use this page to manage, edit and moderate the comments you want to include on your website. If you
allow comments on your pages and/or posts, these are the comments left by your viewers. This page
lists comments for both pages and posts and generally moderating comments is the same for both.
You can choose to display comments on your blog, or pings from other blogs. Refer to ‘Trackbacks

and Pingbacks’ in the glossary for more information about pings.

Your general settings (Options—> Settings—>General), your privacy settings (Options—>Users), and your
post options (Home—->New Page, or Home—>New Post) determine if comments are allowed, who can
leave, moderate, edit, or reply to comments, and who is notified when a comment is left on your

website. Refer to these sections to find out more about your available options.

If you allow comments but require comments to be moderated, when a comment is left on your
website, an e-mail is sent to your administration account (Users->Options—>Profile). If you, or
someone else, reply to the comment, an e-mail is sent to the author's account
(Options>Users—>Profile). Note, an e-mail notification is not sent to the administration account if the

option “An administrator must always approve the comment" is disabled.

Use this page to moderate comments that have been left for your posts. The comments page lists the
author of the comment, the authors e-mail address, and IP address (which can be used to block users
from leaving comments). If the comment is created in Artisteer.net, the e-mail address is from the user
profile, otherwise, if the comment was created on your website, the comment author provides this

along with the comment text (see Options-> Settings—> Discussion->Other comment settings).

The text of the comment is listed alongside the post the comment references. The ‘In Response to’
column shows the post title, the number of comments approved and included in your website, and if
you hover the mouse over this column, the page displays the number of comments that are pending
approval. All the comments that need approval are highlighted on the page to make them more

accessible.
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~ : Screen Options =
ommenis

Search Commenis

All | Pending Approved | Spam Trash
Buk Achions .T Apphy Show all comment types |T Filter
Author Comment In Response To
bob ubmited 2011709730 at 10:00 pm Testimonaals
bobswebsite.com | recommend Bemard n =

bobg&hoimail com
127.0.01

roadrunner Submited on 2011/09720 at 6:50 pm Practices

anyone{fanymail. com Excelent information =

o.com

127.0.0.1

roadrunner Submited on 2011/09730 at 6:49 pm Practices

anyonei@anymail. com Do you handle personal injury? #

127.0.0.1

Author Comment In Response To
Buk Actions l=| | Apply

At the top of the page are five links you can use to change the type of comments displayed.

e All— all of the pending or approved comments.
e Pending — all of the comments that have not been approved yet.
e Spam — all of the comments in the spam bin.

e Trash — all of the comments in the trash bin.

If you hover the cursor over the text of each comment, you should see a menu of actions you can take

on each comment. The actions are:

e Approve/Unapprove — New comments are always ‘pending approval unless you have
configured your discussion options to automatically approve comments. Note, you can use
‘Bulk Actions’ to approve or unapprove several comments at once.

e Reply — Reply to a comment.

e QuickEdit — Change the content of the comment.

e Edit — Same as QuickEdit except you can also change the status of the comment (i.e.
Approved, Pending, Spam).

e Spam — Move the comment to the spam bin. On some websites the spam bin is sometimes

used to hold comments that special plugins, like Akismet, can learn from to block future spam
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comments. Artisteer.net does not currently support this but it may be added later. Note, you
can use the ‘Bulk Actions’ to move comments to the spam or trash bins.
e Trash — Move the comment to the trash bin. Items in your trash bin may be deleted after 30

days. Pages, posts, and other items stay in the Trash bin for 30 days as well.
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Use this to open a new browser tab, or window on your website. This is what your viewers will see
when they visit your website. (Except note, if you have enabled ‘Show Edit’ on the desktop, and you
are currently logged in, an ‘Edit’ icon and link will appear next to the page or post title on the page (if
you have configured this on the desktop: Content->Metadata—>Icons—>Edit). Selecting this link will

open the Editor page in Artisteer.net. If you are not logged in, this link will not appear on the page.)
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The Extras tab displays additional features you can use to manage your web site(s), pages, and posts.

Dashboard Websites

Main

2

Dashboard
Websites
&
Theme

N

Feedbacks

h..

Library

3 52 8B €@ @ O BB

i L

Theme Library Mew Media Links Mew Link Categories Widgets

Media Links Widgets

This page is an overview of your web site. Use this to view statistics of your
web site (e.g. number of pages, posts, comments, etc.), view comments, or

quickly create new posts.

This page displays a list of all your web sites under the account you have

logged into on Artisteer.net.

Use this icon to change options related to all the pages and posts on your
web site, such as allowing or disallowing Comments, changing the
appearance of the horizontal menu, or sidebar(s) and footer.

Use the Feedbacks icon to display a list of all feedbacks.

Use this to display a list of the media in your media library. The media library
is a central location where you can upload media (i.e. images, video files,
etc.) to Artisteer.net. The media library can be used to include media in your

pages or posts. When you add media to your web page or post from the
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desktop, the media is automatically added to the media library when you
Publish your web site. The media library also allows you to search for media
by date or by name.

Use this to add media to the media library. The media you can upload is the
same as the formats supported in Wordpress; allowed file types: .jpg, .jpeg,
.png, .gif, .pdf, .doc, .ppt, .mp3, .mp4a, .wav, .avi, .mp4, .mpt, .mov, and
.wmyv. For security reasons, Flash files (i.e. .swf, .flv, etc.) are not supported
(except for Artisteer’s flash files which you can include in your header).

Use this to create a list of hyperlinks, or multiple lists using link categories
(not the same as post categories). A list of links is referred to as a blogroll.
By default, Artisteer includes a sample link list called ‘Featured Links’ which
are links to features on the Artisteer products web site (Artisteer.com).
Blogrolls are used to create blocks in the sidebar that are a list of hyperlinks.
To add such a block, go to the Widgets section and drag the Links widget into
one of the widget areas, then choose a link category. This adds the block

with a list of hyperlinks for the category you selected.

Use this to create a new hyperlink and assign the link to a category set.

Note, on the desktop, you can add a hyperlink to a page or post with the Edit
tab but this is not the same as adding a link to a link list. A link list is used to
create the content of a blogroll which is displayed in the sidebar (i.e. a list of
links to the side or your page or post content). You can only create a link list
on Artisteer.net.

Use this to create a link category. Categories are used to create multiple link
lists (sets). These are not the same as post categories. By default, your
website already includes a category list called ‘Featured Links’ which is a list

of Artisteer web addresses.
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LJ) Use this to access the Widgets area. This area is used to manage features
0
in your sidebar. Every web site comes with a number of built-in widgets,
Widgets such as a Search widget, or Calendar widget, which you can add to your
sidebar.

Although Blocks appear in the widget areas, Widgets are not the same as
sidebar Blocks. Widgets are based on built-in features. Some widgets are
available on the desktop when you create a new ‘website or blog’ project:
Vertical Menu, Search, Archives, Blogroll, Categories. Other widgets are
available only on Artisteer.net: e.g. Calendar, Tag Cloud. On the desktop,
you cannot change the content directly since the content is either a built-in
feature or based on entities like post categories, or link lists which are

created on Artisteer.net.

Blocks are free-form content you can add on the desktop (Layout->New
Block). You can change the position of blocks in the sidebar on Artisteer.net,
or delete them but you cannot add them. After you add the block to your
design on the desktop, you can change the title, and add content such as

hyperlinks, text and images.
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The Dashboard is an administration page. It shows you basic statistics about your website:

e Number of Pages, Posts, Categories, & Tags

e Number of comments left for your posts. The number of approved comments, pending approval
and number of comments marked as spam.

e How much diskspace you are using on Artisteer.net.

e |If you allow comments for your Articles, a list of the comments received.

e If you allow other websites to link to yours, then a list of these sites.

e Alist of any draft changes you have made to your posts, but not published.

e A simple editor called ‘QuickPress’ which you can use to create simple and quick posts to your

site.
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Use this page to view all of the websites registered for your account on Artisteer.net. The list includes
websites either you have created, or you have been invited to participate with (see Options—>Users).
You can also use this page to change the Primary Site, which is the default site you are working with
when you login to Artisteer.net. Changing the Primary Site does not change the site you are currently
working on. To change the current site, select the ‘Dashboard’ link next to the site you want work with,

or change the subdomain in the address bar of your browser.

Artisteer.net is a Wordpress based hosting service. With self-hosted Wordpress sites, you can have
several themes installed and you change the appearance of your website by changing which one is
active by default. Each theme you add to a Wordpress site has specific theme options which apply to

how that theme works. Remember, when you create an Artisteer.net project, you do not work with the
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theme directly, but there is a theme created based on your ‘style’ design, and published with your
pages. Although Artisteer.net only supports Artisteer themes, and there is only one theme associated
with your website, the Theme page has been included to be consistent with other Wordpress sites

using Wordpress themes created by Artisteer. Consider the Theme page additional options you can

page

use to enhance your website.

Whenever you make changes to these options, always select ‘save changes’ at the bottom if you want

to keep your changes.

Use the ‘reset to default’ button to revert your changes back to the default

settings when your website was created.

Page

Comments Allow

Menu

Show Home Item

Home Item Caption

Default Horizontal
Menu Source

If this option is enabled, viewers can leave comments for your page (the
option should be enabled in the Comments bar for each new/existing
post). If you turn off this option, comments will be disabled on all pages of

your website.

Another option, i.e. ‘Allow people to post comments on new articles”, is
used to set the default “allow comments” value for new pages (Options ->

Discussion)

Typically for a Wordpress blog (and Wordpress theme), the frontpage of
the blog lists the articles posted for the blog. The frontpage is normally
designated the Home page on the navigation bar, and the caption is
‘Home’. Select this option if you want the first choice on the menu bar to
appear with the caption defined below. If unselected, and the source for
your navigation bar is ‘pages’, this will be the title of your first page.

Use this to change the Home choice caption on the navigation bar (first
choice in the menu). If ‘'show home item’ above is unselected, this does
not apply.

Use this to set the source of the menu choices in the navigation bar to

either the ‘Categories’ of your website, or the ‘Pages’ (page titles).
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Source

Post Thumbnails

Use Auto Thumbnails

Thumbnail Width
Thumbnail Height

Post Excerpts

Use Auto Excerpts

Excerpt Length

page

Use this to set the source of the menu choices in the vertical menu to

either the ‘Categories’ of your website, or the ‘Pages’ (page titles).

When your post articles are listed on your Blog Posts page, you can either
choose to have no image displayed next to the article, use a featured
Image (an image you chose to associate with the post when you created
it), or have Artisteer automatically generate a thumbnail image from the
first image in the gallery.

Use this to set the maximum width of the thumbnail image.

Use this to set the maximum height of the thumbnail image.

Use this to let Artisteer automatically create an excerpt from the post
content. This option is ignored if you have defined an excerpt when you
created the post, or if you use the <more> tag within your post.
Otherwise, a defined number of words are automatically extracted from

the beginning of the post text and used as the excerpt.

There are two ways this can be overridden. First, when you create the
post, you have the option on the edit post page to add an excerpt to the
post article. If this option does not appear on the edit post page, check the

screen options and make sure ‘excerpts’ is included in the options.

You can also override this option by inserting a <more> tag. On the edit
post page, switch the editor to HTML mode, and position the cursor at the
end of the text where you want the excerpt to end, then add the ‘more’ tag
using the editor menu bar. When displayed, everything up to the <more>
tag will be displayed for the excerpt.

From the start of the post, this is the number of words that will be included

in the excerpt.
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Apply Excerpt Tag
Filter

Allowed Excerpt Tags
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Use this to make sure that the excerpt is not too short.

This is the minimum number of words of the remaining content that are
acceptable for exclusion from the excerpt. For example, if you have a
short article, and the excerpt includes all but the last 5 words of the article,
if this were set to 5, then the whole article would be displayed.

Use this to strip HTML tags from the excerpt content. For example, you
could use this to remove certain text formatting so your excerpts all have a
consistent appearance.

This is the list of acceptable tags. Any other tags that appear in the

excerpt are stripped from the HTML code.

Default Sidebar Style

Primary Sidebar

Secondary Sidebar
Top Sidebars
Bottom Sidebars

Footer Sidebars

Use this to apply a default styling to the widgets in the Primary widget

area.
Each widget can have a different style applied:

Block — the styling you defined in Artisteer for blocks.
Post — the styling you defined for post articles (e.g. text)
Simple text — bare-bones widget styling

When you add a widget to a widget area, you can choose one of the
above stylings, or select ‘default’. If you select default, the option you set
here applies to the widget.

Use this to set the default styling for widgets in the secondary widget area.
Use this to set the default styling for widgets in the top widget area.

Use this to set the default styling for widgets in the bottom widget area.

Use this to set the default styling for widgets in the footer widget area.
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Footer

Footer Content This is the content that appears in the footer area of your pages. You can

change or replace the HTML code directly.

Note, on the desktop, you can edit the content directly using the Edit tab
on the Ribbon bar to style your content. You can also edit the HTML code
directly for the footer. This is useful if you want to redefine the number of
links at the bottom. This option matches the content you created on the
desktop. i.e. This content is synchronized. If you change the content
either on the desktop or the web, when you publish your website, Artisteer
will make sure that the content is the same for both your Artisteer project

(.artx file), and Artisteer.net.

Note, this content is different from the ‘footnote’ content which can

changed in the Export options on the desktop.
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This page displays all of the media that have been added to your media library. Underneath each

title, you have three options (similar to editing a page or post):

Edit — Use this to edit the attributes of the media file (e.g. Title, Caption, etc.). The attributes
you can define vary depending on the media type. See Inserting Media in your Pages or Posts
section above for a description of these attributes. What you can edit here is almost identical to
what you can define or change when you actually insert the media in your page or post except
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you cannot define attributes related to the appearance (size and placement), and interaction
with the media (e.g. Link URL) since you may use the same media on different pages. File URL

here is the location of the file in your website on Artisteer.net. This cannot be changed.

You cannot edit the files themselves (e.g. edit video). If you are working with an image file, you
can use the Edit Image button directly beneath the image to rotate, scale, or crop the image.

However, you cannot directly manipulate the image.

Delete Permanently — This removes the media from your library and Artisteer.net but does not

remove the source (e.g. the source of the file on your computer).

View — A special page is created for every media instrument you add to your blog. These may,
or may not be accessible to your viewers depending on how you define the media links (see
‘File URL’, and ‘Post URL’ below) for each file in the library.

You can filter the list by date or search for media based on the description you enter for each file. The
table displays the title, who added the media, the page or post where the media has been added to the
gallery, the date the media was last updated, and if there are any pending comments for the picture
(remember, if you set the Link URL to allow users to open, say a picture in a special page on your

post, and you allow comments on your page, users can leave comments for the picture).

Every time you add an image, video, audio file from your computer, etc., the file is uploaded to your
website on Artisteer.net and included in your media library. Only the files that you have uploaded to
Artisteer.net are added to the media library. Media that you link to on the web, such as images or
videos, are not included. (Note, the media library also includes any images you have added to your
page or post on the desktop (Edit->Insert->). These files are automatically copied with your project

when you publish your website.)

Once the file has been uploaded, it is added automatically to your media library. If the upload was
successful, you can add captions, descriptions and other attributes to the media, then apply these
attributes with the ‘Save all Changes’ button. The attributes you can define for any instrument
depends on the type of media you have uploaded. For example, for an audio file, the Upload New
Media page will look like this:
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Hide

File name: Sleep-Away.mp3

File type: audio/mpeqg

Upload date: October 5, 2011

Title Sleep Away
Caption
Description
P
File URL http:// mysite|_artisteer net/files/2011/10/Sleep-Away. mp3
Location of the uploaded file.
Delete

Sawve all changes

You can also edit these attributes later from the media library list. Refer below to the New Media page
for a description of the attributes you can edit for each type of media. When you add the media to
your page or post, there are additional attributes you can set related to publishing in your content.

Refer to ‘Adding Images, Video, and Other Media’ for the Edit Post page above.

Use the Media Library page to manage the files that you have uploaded. Use the ‘delete permanently’
link to remove files from the library. This deletes the file from your library but does not affect the

original file and you can upload the file again later.

Every time you insert media into a page or post (e.g. from New Page, or New Post), the media is
added to the media gallery and also added to the media library. Every page or post has a media
gallery which is a collection of images, video, audio files, etc. attached to the content. If you add
media directly to the media library (i.e. New Media), you can link media from your library to pages or
posts without actually including them in the content. When you add an image, video, or audio file, etc.,
the file is added to the media library but not attached to a page or post. Use the ‘attach’ link under the
‘attached to’ column to add the media to the gallery for the page or post. See Edit post page above for

more information about galleries and how to use them.
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The Media Library page lists each piece of media by name, who added the media (author), which page
the media has been added to (Attached to), and how many comments are pending for the page or post

the media has been attached to.

The media in your library can be images, sound, video, and various document types. Artisteer.net
allows you to upload any file type that is Wordpress compatible (i.e. any type you could upload to
Wordpress.com). This includes .jpg, .jpeg, .png, .gif, .pdf., .doc, .ppt, .mp3, .mp4a, .wav, .avi, .mp4,
.mpg, .mov., and .wmv. Flash files (.swf, .flv, etc), for security reasons cannot be added to your media
library, but you can embed these videos using an URL reference; see the ‘Press This’ tool
(Options—> Settings—>Tools).

When you add images to your pages or posts, you can select them from here (“Media Library”), add
them from your desktop (which also adds them to your library), or include them from another website

using an URL reference. See Home->Posts->New Post.

Use this page to add media files to your media library. Selecting this choice on the Ribbon bar is the

same as selecting the ‘Add New’ button on the Media Library page (see above).

Note, the maximum size of the media file you can upload is 5MB, and the maximum space your

website can occupy on Artisteer.net is 200MB.

If you have Adobe Flash player, your browser will use this by default to select and upload your image
files from the desktop. Using the Flash uploader, you can select and upload more than one file. If you
have trouble uploading your files, or you do not have Flash, try the Browser uploader instead, however

the Browser uploader will only upload 1 file at a time.

After uploading your image files, the page will display a list of all the images that have been received.
If you uploaded a single file, you can add attributes to each file in your library. The attributes vary
depending on the type of file that you uploaded. See Inserting Media in your Pages or Posts for more

information about how to define the attributes for each type.
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A Blogroll is a list of hyperlinks you can display on your website to make it easier for viewers to
navigate your blog or website, or jump to other content in other sites. A ‘website or blog’ project
already comes with a list of links called Featured Links which are links to various topics on the
Aristeer.com website. This list is only for illustration. You will want to change this list when you create

your website.

The Links page displays all of the hyperlinks you have created so far. Use this page to manage your

links.
O -
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You can display the links by category, or search on links by name, URL, and description.

Use the ‘Add New’ button to redirect the browser to the New Link page.

To edit a link, move the cursor over the link you want to change and select Edit below the link name.
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Dashboard Websites Theme Library Mew Medea Links Mew Link Categories Widgets
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== Screen Options -
Edit Link

Basic

Hame

Artistesr Forum

Example: Nifty blogging software

Web Address

http://wew.artisteer.com/ ?p=forums

Example: http://artistesr.conf — dont fargst the http:s/

Description N

norm L’

This wil ba shown when someons hovers over the ink in the biogrold, or optionally below the ink

Target
Edit Link

Name This is the name of the link as it will appear on your web page.
Web Address This is the URL you want to redirect the browser to. Don’t forget the http:// at
the beginning of the address.

Description This is a short description explaining the link. On the Links page, you can
find links by searching on words within the description. In some browsers,
the description is displayed below the link when viewers hover the cursor
over it. Note, when you add the list to a widget area, you have the option of
including the description alongside the link in the list (see
Extras—>Widgets—>Widgets).

Categories You can manage your links by creating categories associated with the links.

When you add a blogroll to your web page, you can choose the category of

links you want to display in the list. On this page, select the categories you
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want associated with the link. Note, a link may belong to more than one
category. Also, ‘categories of links’ is not the same as the categories for
your posts. Post categories are a way of organizing your posts by
hierarchical topics. Link categories are a way of naming your sets of links

and they have no hierarchical order.

Use the Add New Category option to create new categories for your link lists. You can choose to
display all of the link categories you have created, or just the categories most used in your blog. You

can also use the Link Categories page to add new link categories (Extras—>Links—>Categories).

New category Name of the category. When you add a blogroll to a widget area, you have
name the option of entering a title (caption above the list) for the list. If you do not

specify a title, the name of the category will appear.

Use the Link Relationship panel to define relationships to other websites you may be linking to.

Rel If you are linking to someone else’s website, you can specify your
relationship to them. This is called XFN. XFN stands for XHTML Friends
Network. This can be useful for search engines or other services because
you can define a machine exploitable link that adds semantics to your
website. For more information about usage, refer to the XHTML Friends

Network.

Use the Advanced panel to define additional attributes of your link.

Image Address Display an image next to the link on the page.

RSS Address Enter the RSS feed URL for the blog you are linking to. Some themes
display the address alongside the link. Artisteer does not support this.

Notes Optional information about the link. This is not visible on your web page.

Rating Some themes display the links in a blogroll by their rating. Artisteer does not
support this. When you add the list to a widget area, you have the option of
including the rating alongside the link (see Extras—>Widgets—>Widgets).

Keep this link Select this if you want to keep the link but not have it displayed in the blogroll.
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Use this page to create new links for your blog. The options on this page are the same as described

above for the Edit Link page.

Use this page to add new link categories. You can also add new categories when you create or edit

the link (New Link, Edit Link pages) and then later use this page to complete the description.

Name — name of the category. When you add a blogroll to a widget area, you have the option of
entering a title (caption above the list) for the list. If you do not specify a title, the name of the category

will appear.

Description — some text describing the list category. This will not appear on your website.

This page is for managing the widgets on your pages. Widgets are built-in tools you can use to
enhance your blog pages. On the desktop, there are five built-in widgets you can add to your pages
(Layout->Blocks>Widgets). There are other widgets available on Artisteer.net. Use this page to set

where the widget should appear on the page.
Desktop built-in widgets:

e Vertical Menu — The source for the vertical menu can be pages (you can select which pages to
include), categories, or a custom menu (Extras—>Widgets—Widgets—> Select the Vertical Menu
widget in the sidebar area->Source).

e Search — A search field for searching the content of your website.

e Categories — A list of post categories you created for your website. Each link redirects you to a
page listing all the posts for that category (e.g. all posts about dogs).
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e Archives — A list of post articles archived by date. Each link directs you to a page listing all the
posts for that timeframe.
e Blogroll — A list of links you created for your website. When you add the blogroll, you can select

the link category you want to include (e.g. all links about dogs).
Widgets, available on Artisteer.net:

e Archives, Categories, Search, Vertical Menu (see above)

e Links - Your Featured Links.

e Pages - Your site’s Pages.

e Recent Posts - The most recent posts on your site.

e Text — The widget allows users to add text, video, images, custom lists, and more to their
websites.

e Calendar - A calendar of your site’s posts.

e Custom Menu - Your custom menus as a widget.

e Meta - Log in/out, admin, feed and Artisteer.net links.

e Recent Comments - The most recent comments.

e RSS - This widget displays the most recently published content from any source with an active
feed.

e Tag Cloud - Your most used tags in cloud format.

e Twitter - Display Tweets from Twitter.

Widgets can be placed in widget areas. The following diagram shows the widget areas in
Artisteer.net. The ‘content’ area refers to your page or post content (i.e. text, images, etc.). The
diagram also shows the style applied by default. You can change the default styles applied in your

theme options, and also change the style applied to the widget when you add the widget to an area.

On the desktop, you can define the number of columns to include in your template (Layout->Columns).

This option reserves space on your page for sidebars. Your options are:

e 1-column — No sidebar
e 2-column — 1 sidebar

e 3-column — 2 sidebars
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The widget areas depend on the layout of your template. You can add widgets to these areas but if
you change the Layout, the widgets may not appear on your page. For example, the primary and
secondary areas are your sidebars. If you define a one column layout neither of these areas will

appear on your page.

first top second top
content '| primary secondary
i Default Position Style
} Block Style (art-block)
first bottom second bottom
Article Style (art-article)
first footer ‘ second footer ‘ third footer fourth footer No Style (art-nostyle)

On the desktop, when you create a new template, Artisteer will add widgets automatically to your
sidebars to show you how your pages will appear. You can change the widgets in your sidebars, but
you should use the Widgets page on Artisteer.net to manage your widgets instead of the desktop.

There are several reasons for this:

e On the desktop, the only areas where you can add widgets are the sidebars (primary and
secondary areas). In Artisteer.net, there are several more possible areas where you can place
your widgets.

e |If you add widgets to a sidebar in Artisteer.net, they replace any widgets you have assigned on
the desktop. For example, suppose your sidebar has a Vertical Menu, and later you add a
Calendar widget to the sidebar in Artisteer.net. The Calendar widget will replace your menu; it
will not be added to the area. If you want the menu to appear on your page, you need to add
the Vertical menu back to the sidebar using this page in Artisteer.net.

e There are many more widgets available on Artisteer.net than on the desktop.

e You can change the style applied to the widget (e.g. block style, post style) on Artisteer.net.

The Widgets page operates in two ways which you can change in the Screen options:
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e Accessibility mode disabled — you add widgets to your page by 1) selecting a widget area
(select the icon next to the area name) to expand the list of widgets that have been added to
that area, 2) dragging and dropping a widget from the list of available widgets on the left, to the
open area. You can also use drag&drop to rearrange how the widgets will appear in the widget
area.

e Accessibility mode enabled — drag&drop is disabled. To add a widget or change a widget in an

area, you use the links next to the widget name (e.g. Add).

On the left side of the page are all of the possible widgets you can add to a widget area. All of these

widgets are the same as those available in Wordpress.

Below the list of available widgets is the inactive widget area. Every time you add a widget to an area,
there are certain options you can configure for each widget. For instance, you can apply a particular
style, such as Block or Post, which refer to the styling Artisteer applies to Blocks and Post articles.
Note, if you select Default, the style used is what you define as the default in your theme options
(Extras>Main>Theme). The inactive widget area is for holding widgets you have configured but do
not want to include on your pages. In each of your widget areas, you can either delete the widget, or

drag&drop it to the inactive list, where the widget options are still configured.
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Use this to access your user profile (logged in account).

Use this to access a list of users who have specific roles regarding your web
site (e.g. backend administrative access). There are five pre-defined roles

you can use to assign specific roles to existing users on Artisteer.net.

Subscriber — you can read and write comments.

Administrator — you have access to all of the administration features.

Editor — you can manage and publish posts.

Author — you can publish and manage your own posts. When you create

new posts as an Administrator, you are also the Author of the post.

Contributor — you can write and manage posts but not publish them. You
cannot upload media files.

Add New creates a new user account on Artisteer.net, or you can invite an
existing user to join your web site. In both cases, Artisteer sends an e-mail to
the user you create or invite. Others you invite will see this site now appear

under their list of sites (Extras->Main—->Websites), but the administrative

artisteer.net | page 104



Privacy

-
e 28

al

Permalinks

Writing

&Y
Reading

<1 Media
d Lightbox

= Discussion

#* Tools

page

options (ribbon bar) will change depending on their role as described above.

Use this to access your most basic configuration settings such as how
date/time values are displayed on your web site, your e-mail address used for
administration notifications, keywords and meta tags for search engine
optimization, etc.

Use this to decide if your web site is accessible to search engines such as

Google, or Technorati.

Use this to change how the permanent URLSs are created to access your
individual posts, categories, or other postings. See the Permalinks page
below for more information.

Use this to control the editing features when you are writing new posts. You
can also use this to access the ‘Press This’ applet, and/or add protocols to
enable Remote Publishing.

Use this to control how your website will appear to viewers. For example,
you determine which page is your default page when viewers enter your web
address. This is equivalent to selecting the top page in your page folder on
the desktop. You can also decide which page your post articles will appear
on. This is equivalent to changing the Blog Posts page on the desktop.

Use this to control how media is displayed on your web site.

Use this to control the Lightbox Gallery options.

Use this to determine whether or not to allow comments, determine what
comments should be allowed and which should be considered spam, how
should comments be moderated, allow Pingbacks and Trackbacks, etc.

Access general tools, such as ‘Press This'.
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Use this to import posts or comments.

Use this to export posts, comments, pages, categories and tags. You can
use the generated XML file to import this content into another Artisteer site.
Delete your website. An e-mail notification is sent to the address of the
‘admin’ user (Options—> Settings—> General) to confirm deletion. If you delete
your website, all of your pages, posts and comments are permanently
deleted. This will not remove your account but you will not be able to reuse
this domain name again (e.g. www.myname.artisteer.net); the domain is

permanently unavailable.

Use this to control whether or not the visual editor is available when you
are editing a page or post. If checked, only the HTML editor is available
(e.g. Home—>Posts—>select post—>Edit).

Use this to enable keyboard shortcuts for browsing and moderating
comments. Press j (down) or k (up) to start navigating and selecting a

comment.
Available shortcuts for performing actions:

e a approves the selected comment.

e s marks the current comment as spam.

e d moves the comment to the trash bin and/or deletes the current
comment.

e 7z restores the comment from the trash bin or activates the Undo
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Name

Username

First Name
Last Name

Nickname (required)

page

action when that row is selected.

e U unapproves the selected comment, placing it back into
moderation.

e rinitiates an inline reply to the comment (press Esc to cancel the
reply).

e ( activates "Quick Edit"

Note that those first three actions (and most common actions) use the
three left-most keys of the home row of a QWERTY keyboard. It is
recommended that you shift your hand to the left so that your index finger

is on ‘d’ instead of on ‘f’, as is normal.

Available shortcuts for performing bulk actions:

e X checks the checkbox for the selected comment.

e Shift-x toggles the checkboxes.

e Shift-a approves the checked comments.

e Shift-s marks the checked comments as spam.

e Shift-d deletes the checked comments.

e Shift-u unapproves the checked comments.

e Shift-t moves the checked comments to the Trash bin.

e Shift-z restores the checked comments from the Trash bin.

Use this option to always use a secure connection when you are making

administrative changes to your web site.

This is your logged in username. This is display only; usernames cannot
be changed.

Enter your first name.
Enter your last name.

Enter an alternate name. This is useful if you want another name to
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Display name publicly

as

Contact Info

E-mail (required)

Website
AIM
Yahoo IM
Jabber / Google Talk

About Yourself

Biographical Info

New Password

page

appear on your blog. Username cannot be changed but this name can be
changed at any time.

If you have enabled the ‘author’ icon in your Artisteer project
(Articles>Header—>Author), this is the name you want to appear in the

citation (e.g. use Nickname instead of Username).

This is the e-mail address used to moderate comments added to posts
you have created on the website. This is not necessarily the same as the
administrator e-mail address listed in your general settings. You cannot
use an e-mail address that has already been used by you or another user
on Artisteer.net.

Your web site address.

Your AOL Instant Messenger screen name.

Your Yahoo Instant Messenger screen name.

Your Jabber or Google talk name.

Short description of yourself.

Use this to change your account password. The ‘Strength Indicator’ can
be used to measure the difficulty it would be for someone to guess your

password.
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Use this page to manage the users invited to participate in using your blog.
Every user, including you, is assigned a role. Users may have the following roles:

e Administrator — you can change any of the administration options and settings in the blog. If
you created the blog, you are the administrator. If you assign someone else as administrator,
they can do anything you can do, including deleting your website.

e Editor — you can do anything an Author can do and some administrative tasks such as
moderating comments, managing categories, managing links, editing pages, and editing other’'s
posts. You can also edit Posts marked ‘private’.

e Contributor — you can upload files and create/editmanage your own posts. Any posts you
create are in ‘draft’ until an Administrator approves the post for publication. You cannot delete
your own posts.

e Author — you can do anything a Contributor can do and also publish your own posts without an
Administrator’s permission. You can also delete your own posts.

e Subscriber — you can only manage your own profile.

Use this page to invite others to participate with your blog. You can either invite users that are already
registered with Artisteer.net, or register new users. To invite an existing user on Artisteer.net, you will
need to know the e-mail address they used to register. To create a new user account, you will need to
supply a new username and e-mail address. Note, you cannot use an e-mail address or username if it
Is already associated with an existing user. In either case, for existing users, and new users, an e-mail
confirmation is sent to the address registered. The user cannot edit your blog until he or she confirms
the registration with the link sent in the e-mail message. Note, the invitation is sent to the e-malil
address in the user’s profile, not the one in the General settings, which is for administration purposes
only. Once the user confirms their invitation, the website will appear in their list of websites
(Extras>Main—>Websites).
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If you have more than one website, this only applies to the website you are changing. Look to the

browser address bar to confirm if this is the website you want to invite the user to (e.g.

mysite.artisteer.net). If you want to add the same user, or another user to a different website, you will

need to change your context to the other website (e.g. by changing the domain name in the address

bar, or Extras>Main—>Websites—> Select the dashboard for the site you want to switch to).

Options
Site Title

Tagline

Default Page Title

Default Page
Keywords

This is the name of your web site.

This comes from the Headline text on your page Header. Normally this
would be the name of your blog or website but it could be anything.
Remember, with ‘website or blog’ projects there are two blocks of text on
your Header page. The first block is the Headline which you can change

directly in the header area on the desktop.

This is some text describing your website.

This comes from the Slogan text on your page Header. Normally this
would be a description of your blog or website but it could be anything.
The Slogan text is the second block of text on your Header. You can
change the text the same as the Headline text (see Site Title above).

The title you enter here becomes part of the <title> tag in the HTML code
for this page. The ‘title’ is used by the browser toolbar (e.g. tabs), as the
bookmark title for the page if added to the browser bookmarks, and in

search engine results.

Note that Default Page Title refers to the HTML <title> tag, and it does not
change the page name (heading) that appears in the content field.
This is a comma delimited set of keywords to describe your site. The list

is included in your web page as a meta tag element:

artisteer.net | page 110



Default Page
Description

Default Meta Tags

E-mail address

page

<meta name="keywords” content="poodles, dogs” />

This is the default list of keywords for your page if not specified when you
created the page on the New Page page (Home—->Site>New Page). This

is added to your page, if ‘keywords’ is not already defined in an existing

page.

These can also be assigned on the desktop (File>Export
Options—>Default Page Tags).
This is a description of your page. The description is included in your web

page as a meta tag element:

<meta name="description” content="this is a page about dogs” />

This is the default description for your page if not specified when you

created the page on the New Page page (Home—->Site>New Page).

This can also be assigned on the desktop (File->Export Options—>Default
Page Tags).
Use this text box to add the HTML code to define the meta tags you want

included. These are important to the search engine rankings for your

page.

<meta name="author” content="Bob Smith” />
<meta name="contact” content=bsmith@robertsmith.us” />

This is the default code you want added to a page, if you did not specify
any meta tags when you created the page on the New Page page
(Home—>Site>New Page). This is added to your page, if no meta tags

have already been added to an existing page.

These can also be assigned on the desktop (File>Export
Options—>Default Page Tags).

This is the e-mail address Artisteer will send messages to regarding your

web site administration and maintenance. This may be different from the

artisteer.net | page 111



page

e-mail address used for the Admin user (see Profile page). For
confirmation of comments posted by users, the e-mail address of the

Admin is used, not this one.

Note, notification about the approval of the comments is sent to both the
administrator and author (the attribute “A comment is held for
moderation”).

Timezone Select your timezone based on the Coordinated Univeral Time. Your
timezone is the number of hours that differs from the UTC Greenwich
Mean Time (UTC+0). You can also select a major metropolitan area that

is closest to your location.

When you publish your pages and posts, there is a timestamp assigned to
your changes. If you include a date tag with your posts on the desktop
(Content->Metadata—>Icons—->Date), the date shown on your page is
based on this timestamp. If you do not change the Timezone for your

website, the date shown may not be correct for your local time.

If you schedule a date and time when your page or post should be
published (instead of publishing immediately), you should change the
Timezone to reflect your local time, otherwise the content may not be

published when you expect.

Date Format Select the format that you would like dates displayed on your web site.
Time Format Select the format that you would like clock times displayed on your web
site.
Week Starts On Select the preferred day that you would like Calendars displayed on your

web site. If you add a Calendar widget, this is the start day for every week

that appears on the Calendar.

Options
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Site Visibility Select whether or not your web site should be accessible to search

engines or archivers, such as Google, or Technorati.

Each blog post and resource (e.g. image, or video) has its own web page. The web address of that
page is called a permalink. Permalinks are designed to keep a permanent reference to content on
your website. For example, when you create a post, you might revise the content of the article later,
but you want to create the post, and you may want other users (or yourself) to link to your post from
other blogs. If a CMS, in general, dynamically kept changing the URL address of the pages to your
website, it would never be possible to make sure the references from other blogs was correct. To
solve this problem, a Permalink is created every time you post your article. As long as the article
remains on your blog, other authors can make references to your posts, and the URL addresses are

guaranteed to be valid.

Permalinks are created automatically but usually they are not always self-evident. To make them
more readable (to you and search engines, and other services), you can change how Artisteer.net

creates the link.

Options
Common Settings Use this option to configure how your Permalinks are created for all of

your posts.
Default — an ID number is assigned to each post.

Day and Name — the URL includes the year, month, day and post

slugttitle.
Month and Name — the URL includes the year, month, and post slug/title.
Numeric — a numerical value is assigned to the URL.

Custom - use the Custom Structure option to define a custom link based
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on the position of tags that you can arrange to form the URL.

%year% - 4-digit year (e.g. 2007)

%monthnum% - 2-digit month (e.g. 02 for February)

%day% - 2-digit day (e.g. 30)

%hour% - 2-digit hour of the day based on 24-hr clock (e.g. 15 for 3
pm)

%minute% 2-digit minute (e.g. 45)
%second% - 2-digit second (e.g. 10)

%postname% - normally the postname with hyphens separating the

parts of the name

%post_id% - the unique ID assigned to the post

%category% - text name of the category the post was filed in

%author% - text name of the author of the post

%tag% - text name of the tag associated with the post

When creating a custom structure, make sure to include the
slashes before, between, and at the end of the string of tags so the
URL is created properly.

Note, changing the structure of your Permalinks affects both old
and new links. Search engines often index sites based on the
Permalinks so if you change the structure, your old links may
become obsolete.
Optional Use this to customize your Permalinks by changing the prefixes used in
the URLs.
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Size of the post box

Formatting

Default Post Category

Default Link Category

Remote Publishing

page

The Category base and Tag base prefixes look like this:

Mysite.com/wp/category base/category_name

Mysite.com/wp/tag_base/tag_name

The default names are ‘category’ and ‘tag’. Use the textboxes on this
page to change the default. Note, you can change the base names but

you cannot remove them altogether.

Choose the number of lines that you would like for the content box that
appears for entering post articles (see New Post page).
Use this to automatically convert emoticons entered in text (e.g. :-)) to

icons (e.g. ©).

You can enable an option that lets Artisteer correct invalid XHTML. e.qg. if
you enter HTML, copy&paste, or use the visual editor, you must make
sure that your HTML is XHTML 1.0 compliant, otherwise there is no
guarantee that your content will appear as you would like. Enabling this
option allows Artisteer to automatically correct invalidly nested HTML
code.

This is the default category your posts will be assigned to. You can
override this when you post your article.

When you create a list of links, this is the default link category your link list
will be assigned to. You can override this when you create the list of links.
Use this to enable the Atom Publishing Protocol or one of the XML-RPC
publishing interfaces that allow you to post to your website from a remote

web site or a desktop publishing application.
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Front page displays

Blog pages show at most

Syndication feeds show

the most recent

For each article in a feed,

show

Encoding for pages and

page

This is the default page displayed when your viewers enter your web
address (e.g. mywebsite.artisteer.net). Note, you can pick any page
that is in your site but you probably do not want to pick a page that is

used just as a menu separator, or one that is a child of another page.

You can also select a page that displays all of your post articles. On
the desktop this is shown as your ‘blog posts’ page in your page
folder. You can also set this option on the desktop by right-clicking on
the page name, and select ‘Use as Blog Page’ from the menu. When
you change blog pages, all of the content of your existing page is
replaced with your post articles. The content is not lost however; you
can get the content back by changing the blog posts page to another
page.

This sets the maximum number of post articles that will be displayed
on your ‘blog posts’ page.

Enter the maximum number of posts that you want to show in an RSS
feed at any time.

Full-text, or summary. Full-text publishes the entire post to an RSS
feed, while summary publishes a partial excerpt.

The default is UTF-8. Character Encoding is the character code used

feeds in the storage and transmission of the text in your website. UTF-8 is
the most common encoding used and it handles a wide variety of
languages, and character representations.
Image sizes
Thumbnalil size When you insert an image into a post and you choose to insert the image

in Thumbnail size, these are the dimensions that are used.
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Medium size When you insert an image into a post and you choose to insert the image
in Medium size, these are the dimensions that are used.
Large size When you insert an image into a post and you choose to insert the image

in Large size, these are the dimensions that are used.

Embeds

Auto-embeds Use this option to automatically embed video files into your pages or

posts. Artisteer.net supports the video embeds for the following services:

e YouTube (only public videos - "unlisted" and "private" videos will not
embed)

e Vimeo

e DailyMotion

e Flickr (both videos and images)

e Viddler

e Hulu

e Reuvision3

e Scribd

e Google Video

e WordPress.tv

e SmugMug.

When you add video to your page or post using one of the editors (see
Inserting Media in your Pages or Posts), the editor inserts a hyperlink to
the video so what your viewers see is a link, not the actual video on the
page. Furthermore, for security reasons, you cannot upload flash files to
your media library, but using this option, you can embed videos in your

content, and you can embed flash video from other websites.

Note, this is one way to embed video; there are many other methods

described on the web but since they are not specific to Artisteer.net, they
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are not covered here.

If you turn on this option, there is no need for any HTML code to embed
the media. All you have to do is enter the URL to the media as text in your
page. You get the URL from the site you are referencing. For example,
with youtube.com, when you click on a video, normally, you will get an

URL that looks something like this:
http://www.youtube.com/watch?v=nTDNLUpg.

The URL has to be inserted in your HTML code as text, not a hyperlink,
and the URL has to appear on its own line. If you find the URL has been
inserted/changed to a hyperlink, you need to modify the HTML and
remove the code wrapping the URL so what remains is the URL as text.

Note, this option works when the page is requested by your viewers, not
when the page is updated and published, so if you use this option to
embed video, you should not change it, otherwise your viewers may find

that videos embedded previously, no longer work.

You can also embed video using the [embed] shortcode:

[embed width="123"
height="456"]http://www.youtube.com/watch?v=xisjdjNsc[/embed]

This approach has several advantages;

e |t does not depend on the auto-embeds option.

e You can specify the dimensions of the frame. You do not have to
specify one size.

e The code can appear anywhere. It does not have to be on a line by

itself.

Maximum embed size Use this to set the width and height for the maximum size you want

embedded video or audio files (i.e. the video or audio players) to be within
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your posts and pages. Note, this is the maximum size; the actual size of

the player in the window might be smaller depending on the media.

To insert a Lightbox image gallery into a post/page:

1. Select the Add Gallery icon == in the editor and insert the images from your computer, URL or

Media Library

Uploadinsert = I§ JN 5 ; % -5

2. Adjust the gallery settings (see Adding Images, Video and Other Media) and press Insert

Gallery

Gallery Settings

Order images by Menu order -]
Order @ Ascending Descending
Gallery columns 3 -]

Insert galery
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Add Gallery
From Computer From URL ' Gallery (4) | Media Library

All Tabs: Show Sort Order: Ascending | Descending | Clear

Media Order

H Jellyfish Remove from Gallery
M Tulips Remove from Gallery
H Jellyfish Remove from Gallery

. Chrysanthemum Remaove from Gallery

| saveal changes '

Gallery Settings
Order images by: Menu order |Z|
Order: @ Ascending ) Descending

Gallery columns: 3 |Z|

| Insert gallery |

3. When you click on the thumbnail in the post a lightbox gallery appears, where you can view the

images in more detail. You can adjust the lightbox gallery settings with Options>Lightbox:
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+ Lightbox Gallery Options

In case that wou would like to zet the default number of columns

5|

In case that you would like to set the detault thumbnail size:

Thurmbnail| » |

Im caze that wou would like to set the default ighthox size:

Medium %
Update Options » Reset Options »
Lightbox settings
Set the default Select a number of columns you would like to display the images in

number of columns  (custom value).
Set the default Choose one of the available thumbnail sizes: thumbnail (150x150),
thumbnail size medium (300x300), large (1024x1024), and full. You can customize
thumbnail sizes at Options>Media. Thumbnail size settings are
responsible for the size of thumbnails displayed in a post or page.
Set the default Define the size of the images displayed in the gallery: thumbnail, media,
Lightbox size large, full.

Update/reset options:  Use these options to save the adjustments or return to the default settings.

Options
Default article (page 0 These settings relate to pingbacks, trackbacks, and comments. These

post) settings options set the default behavior for your web site. See ‘trackbacks and

pingbacks’ in the glossary for more information.

“Attempt to notify any blogs linked to from the article” — Artisteer will

send out a ping to another web site that you have linked to (i.e.
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hyperlinks included in your post). Your link to the other site will be
mentioned in their comments section if they have enabled pingbacks.
Disable this option if you do not want other blogs to be aware of your
discussion, or you do not want your reference to be mentioned on the

other blog.

“Allow link notifications from other blogs (pingbacks and trackbacks)” —
Artisteer will accept/decline pings from other web sites that link to your
posts. Pings should appear in your comments section if you have
enabled this option. You can override individual options using the “allow

pings” option on the New Post page.

“Allow people to post comments on new articles” — This option allows
viewers to comment on your post articles. You can override this by
changing the “allow comments” option on the New Post page. Note, on
the desktop, the Comments setting (Content—->Icons—->Comments) only
determines if the footer area of your post includes a ‘comments’ link
(clicking on the link redirects you to a page where you can enter a
comment). Removing this link does not mean users cannot leave
comments. If comments are allowed thru this setting, viewers can still
click on a post article which will redirect them to a page where a
comment form appears at the bottom of the page. If you really don't
want to allow comments, turn this option off.

“Comment author must fill out name and e-mail” — Use this option to
require everyone who comments on your post to fill in the ‘name’ and ‘e-

mail’ fields of the comment form.

“Users must be registered and logged in to comment” -- Signup has

been disabled. Only members of this site can comment.

“Automatically close comments on articles older than H days’ -
This option turns off comments on your posts. After X number of days

that you specify, Artisteer.net will no longer accept comments on your
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Before a comment

appears
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post.

“Enable threaded (nested) comments ° L‘ levels deep” -- If the
setting is 1, your viewers can only comment on the post, and the
comments are then displayed in chronological order. If the setting is 2
or more, viewers can comment on the comments themselves. This
setting determines the level of comments that viewers (including

yourself) can leave comments for.

: . 0
“Break comments into pages Wlth‘ > top level comments per

last

page and the l‘ page displayed by default” — This setting
determines how many comments should appear on one page and
whether or not the comments should be listed last-to-first, or first-to-last,
and also on each page, whether or not the comments should be listed

from newest-oldest, or oldest-newest.

“Comments should be displayed with TRl ctor [l
top of each page” — Comments left by your viewers are listed in
chronological order. Use this option to start with the ‘newer’ or ‘older’
comments that are left.

“Anyone posts a comment” — use this if you want a notification sent
whenever anyone submits a comment. This may not be useful if you

have many people posting a lot of comments.

“A comment is held for moderation” — Use this if you want a notification
sent whenever a comment is held for moderation. The e-mail is sent to
the owner of the website at the e-mail address configured on the
General options page (Options—> Settings—> General).

“An administrator must always approve the comment” — this keeps all
comments in the moderation queue until the administrator of the website

approves the comments. Until approved, the comments do not appear
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Comment Blacklist

Avatars

Avatar Display

page
on the website.

“Comment author must have a previously approved comment” — this
requires that comments left by every first-time commenter must be
approved before they are added to the website. After the first approval,

they remain approved for every comment left afterwards.

Hold a comment in the queue if it contains or more links. (A
common characteristic of comment spam is a large number of

hyperlinks.)”

When a comment contains any of these words in its content, name,
URL, e-mail, or IP address, it will be held in the moderation queue. One
word or IP per line. Artisteer.net will match inside words, so “art” will

match “Artisteer”.

These options are used to prevent spammers from submitting phony
comments to your web site. The comment is held in the moderation
queue, as opposed to being marked as ‘spam’.

“When a comment contains any of these words in its content, name,
URL, e-mail, or IP address, it will be marked as spam. One word or IP
per line. Artisteer.net will match inside words, so ‘artist’ will match

‘Artisteer’.

This option is used to prevent spammers from submitting phony
comments to your web site. The comment is marked as ‘spam’ as

opposed to being held in the moderation queue.

Use this to show, or not show, avatars.

Avatars are photos or images that represent your commenters (and

you) on your blog. Avatars are associated with your e-mail address. If
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you are also a WordPress.com user, your avatar is the one uploaded to
your profile, but when leaving a comment, the e-mail address must
match the e-mail address in your Artisteer.net profile. If you, or your
viewer, are not registered with WordPress.com, you can still use an
avatar but you must sign up for one at http://gravatar.com. When
submitting comments you must use the e-mail address used to create
your account on gravatar.com.

You can restrict which avatars will be displayed on your site by

selecting a rating similar to the standard movie ratings in the U.S. by the
motion picture academy. If you consider your website to be family
friendly, you may not want to display any avatars that are rated above
G, or PG. Note, the rating for a user’s avatar is set by the user when
he or she creates the avatar, so this setting cannot guarantee against
offensive material.

This is the avatar displayed by default when there is no avatar

associated with the e-mail address on gravatar.com.
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‘Press This’ is a tool that lets you copy text, images, and video from web pages. ‘Press This’ is used
to create Posts (not Pages) on your website. To use this, find the link on the page titled ‘Press This’
and add it to the bookmarks for your browser (refer to your browser documentation on how to do this).
This step is necessary since you have to run the ‘javascript’ for this bookmarklet from the current

window where you select the content.

Home Extras Options Administration

— e = L3l General ¥ Writin [ Lightbox ¥ 1 Import
&) &3 . 2 3 L g L@ Lig ] Imp

dlj Privacy |€y Reading 523 Discussion | [3» Export

Profile Users Add New | &3 Permalinks [55] Media f}"{* Tools X Delete Site
Users Settings Data
Tools
Press This

Press This is a bookmarklet: a little app that runs in your browser and lets you grab bits of the web.
Use Press This to clip text, images and videos from any web page. Then edit and add more straight from Press This before you save or publish itin a post on your site.
Drag-and-drop the following link to your bookmarks bar or right click it and add it to your favorites for a posting shortcut.

Press This

Categories and Tags Converter

Use this to convert categories to tags or tags to categories.

Open your browser to a web page you are interested in and select the content (e.g. text, images, or
video), then select the ‘Press This’ bookmark in your browser. This will open a window you can use to

create your Post. Any text you select in the browser will appear in the editor window. Any images or
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video you selected will be added to a gallery. To include the image or video in your post, select the

‘add image’ or ‘add video’ icon, then select the image or video you want to add to your post.

Once you have created your post article, you can save it as a draft, or publish it directly to your

website. You assign the Post to a category, and add tags to make it easier for viewers to find your
article in a web search.

Enter PDSﬂ TItlE Enter Site Title : Press This
Add'—ﬁ m Save Draft || Publish
B I |U) & @|i=|i=Z E = =9 [E]
Categories

All Categories | Most Used

1st category
Uncategorized

+ Add New Category

Post Tags

Add

Choose from the most uzed tags in
Post Tags
Path: p

This tool will convert the ‘categories’ you have created for your website to ‘tags’ and visa versa. The
tool is on the Import page (Options—>Data—>Import->Categories and Tags Converter). You can also
invoke the tool from the Tools page (Options>Tools—>"Use This” link).

If you include ‘Category’ and ‘Tags’ icons in your post footer using the desktop
(Content->Metadata->Icons), viewers can use the links to view articles related to those topics.
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You can create new tags when you add a new post (Home->Posts>New Post), or you can use the

Post Tags page to add to the set of tags for your website (Home—>Posts>Tags), and then later

associate one or more of these tags when you create a new post.

I A FTIET A
A Arisieet

=

Home Extras Options Administration

ﬂ = = (3% General _¥ Writing [ Lightbox  |¢_] Impo
| &3 &}' Al Privacy &4 Reading .23 Discussion | | J» Expor

Profile Users Add Mew =3 Permalinks ﬂ Media % Tools X Delet
Users Settings Dati
Categories to Tags Tags to Categories

Convert Categories (6) to Tags.

Hey there. Here you can selectively convert existing categories to tags. To get started, check the
categories you wish to be converted, then click the Convert button.

Keep in mind that if you convert a category with child categories, the children become top-level
arphans.

Check All I}

[] dogs (D)
[ terrier (0}

[7] shepard (0)
[] anatolian {0}

[] belgian (0}

[] Uncategorized (3)

Conwvert Categories to Tags

The number in parentheses refers to the number of posts associated with categories; basically, how

many times you have used a category. Based on how you associate your ‘words’ to ‘posts’, you may

find, in some circumstances, that your workflow would be better if you converted some of your

categories to tags, or tags to categories. Changing ‘categories’ or ‘tags’ do not delete or modify any
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posts, or change the association between the posts and these key words, but it can redefine your
category hierarchy. You should note the hierarchy of the categories shown above. If you convert a
parent category (e.g. shepard), the child categories (e.g. Anatolian, Belgian) become top-level
orphans. If need be, you can change the hierarchy back to the original format by editing the

categories on the Categories page (Home—>Posts—>Categories).

artisteer.net | page 129



page

Use this page to import content from another CMS. If you are importing content from another
Artisteer.net website first create the WXR file using the Export option on the other site, then select the
Wordpress button on this page to import the content from your file. Make sure that you publish your
website on the desktop (Home->Publish) so the pages and posts in your Artisteer project on the

desktop is synchronized with your content on Artisteer.net

Use this page to export content to a WXR file that you can use to move your content. You can also

use this to archive or back up all or part of your website.

If you plan to move your content to another Artisteer.net site, first create your website on the desktop
(Home—->Publish->create website), then use the Import page to copy your content from the WXR file.

Use this to delete your website. When you delete a website, the content is removed from Artisteer.net
and the domain name is parked forever and cannot be reused again. An email is sent to your site e-
mail address (Options—>General) with a confirmation link. You have to acknowledge the link to confirm
you want to delete the website, otherwise Artisteer will not remove your website. If you are using
another domain name instead of an Artisteer.net domain name (see Domains below), make sure that

you update the nameservers for your hosting service.
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Administration
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Domains  |Google Maps Settings Statistic
General Google Analytics

Use this page if you have, or plan to acquire a domain name that you want to
use instead of your Artisteer.net domain name (e.g. myname.artisteer.net).
Your ‘domain name’ is the web address that your users enter to get to your
website (e.g. www.myname.com). There are many places on the web where

you can purchase a ‘domain name'’.

Follow the instructions on this page. Note, the ‘registrant’ is the service
where you bought the domain name. If you already host your website
somewhere, but now want to use Artisteer.net, this would be your current
hosting service. You will need to contact them to update the Name Servers
as described on this page. Until you have added the Name Servers to your
domain registration, your domain name will not correctly route viewers to your

website.

If you have more than one website on Artisteer.net, you need to first select
your primary site before you add a domain name. On the My Sites page
(Extras>Main—>Websites), use the drop down list to select one of your
websites as your primary site. Whenever you add a domain name, it
becomes associated with whatever your current primary site is. If you are
uncertain about which site is the current primary site, go to the My Sites page
(Extras>Main—>Websites).

Enter your domain name in the textbox under ‘Add new domain’, and save
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your changes.

+ Add new domain

hitp:if
{For example: yournames. com)
Save
Domain Activation
Primary Domain Delete
a hitp:ifmydomainname. com

hitpcf my=site. artisteer.net
Update Pnmary Domamn

The primary domain for your blog is mydomainname.com. The other URLSs above will redirect o that domain

You should notice that one of the domain names (addresses) is selected as
the Primary. This means that any other addresses that appear on the list will
redirect your users to the address that is the Primary domain. You can only
have one Primary. For example, by default, the domain name you add
automatically becomes the Primary address. If you type the Artisteer.net
address below it (e.g. www.mysite.artisteer.net) in the browser, you are
redirected from the Artisteer.net address to the domain you added and the

domain’s URL is what will appear in the address bar of the browser.
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page

Enter the Google API Key if you use a custom domain and would like to

activate google maps.

The Google Analytics settings are used to enable and adjust the service

(Basic Settings and Advanced Settings)

Please NOTE that Google Analytics is disabled by default. To enable the

feature:

1. Select Enabled in the drop down list, which says "Google Analytics

logging is";

e | k]
gfs | &
Domains Settings Statistic
General Google Analytics

Google Analytics Settings

Basic Settings

Google Analytics logging is:

Authenticate with Google: Currently authenticated with Google. Deauthorize Google Analyticatar.

2. Then you should indicate your Google Analytics UID (Log in to your
Google Analytics Account > Select the domain >Click on the ‘Edit’ link
under Settings for the domain you want to find the UID. Now click on
the link ‘Check Status’ after Receiving Data at the top > Your UID
looks like “UA-xxxxxxx-X"). Paste your UID and click Save Changes.
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Home Extras Options Administration
|

@ | Kg}

F-|

" e
Domains Settings Statistic
General Google Analytics

Google Analytics Settings

Basic Settings
Google Analytics logging is: Enabled j

Authenticate with Google: Click here to login to Google, thus authenticating Google Analyticator with your Analvtics account.

licking the abave link will authenticate Google Analyticator with Google. Authentication with Google is needad for use with the
you to select your Analytics account through a drop-down instead of searching for your UID. If you are not going to use the statis

Google Analytics UID: UA-25603753

Enter your Google Analtics’ UID in this box. The UID is needed for Google Analytics to log your website stats. If you are having
in the above field. After returning from Google, you will be able to select your account through a drop-down box.

Save Changes

3. Go to Statistics and select Access Granted

& This website has not registered with Google to establish a secure tion for authorization requests. We recommend that you continue the proce

http://blogtestsite.artisteer.net/wp-adminf/options-general. php?page=google-analyticator.php

[ Grant access ][ Deny access ]

_,-| This option displays statistics, showing visits over the past 30 days, site

usage, top pages, top referrers and top searches.

Statistic
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The back end is the area that authorized users can sign into to add, remove and modify content on the
website. The Artisteer.net back end is represented by Administration Panel often called the Ribbon

bar.

Category is a common title of a group of posts. Categorization helps to arrange and group posts with

similar content and improve the navigation of a website.

Content consists of text, images, or other information published in posts and pages. ‘Content’ and
‘design’ build the website interface. The website design provides a framework into which the content is
inserted, and the presentation of a site. You can use Artisteer on the desktop to define the ‘design’

and ‘content’. You can use Artisteer.net to create and manage the ‘content’ but not the design.

Excerpt is a term generally used in Content Management Systems like WordPress and Artisteer.net. It
denotes a brief manual description and of a blog post, which is used in places where quick summaries
are preferable to full content, such as search results, and archives. The manual WordPress excerpt is
often confused with the automatic excerpt or with the teaser (the part of a post that appears on the
front page when you use the More tag). While both are related to the manual excerpt, they are

different from it. Automatic excerpt displays the first 55 words of the post's content.

You can add an excerpt to a post in Artisteer.net using: Home>New Post> Excerpt Subpanel.
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The front end is what your visitors see in a browser and interact with when they come to your website,

www.YourSite.com.

FTP, or File Transfer Protocol, is rather predictably, a client-server protocol for transferring files. It is

one way to download files, and the most common way to upload files to a server.

An FTP client is a program which can download files from, or upload files to, an FTP server.

From Artisteer, you can either export your pages to a folder or archive (i.e. zip file), and/or move the
files yourself later, or you can use the Artisteer's FTP client to move the files. To use the FTP client,
you must configure certain settings in your Export options (File->Export->Export Options>FTP
Server). Note, this is only needed for static HTML websites. If you are hosting your website on

Artisteer.net, you only need to publish your website from the desktop.

A hosting provider is a company or organization which provides, usually for a fee, an infrastructure for
making information accessible via the web. This involves the use of a web server (including web
server software such as Apache), and may involve one or more related technologies, such as FTP,

PHP, MySQL, and operating system software such as Linux or Unix.

Artisteer.net provides 200 Mb. of free disk space to store your website.

Developed by Netscape and Sun, JavaScript is a client-side programming or scripting language. It's
used to create interactive and dynamic effects on a web page, as well as handle and manipulate form
data. JavaScript is a separate language from Java. All modern browsers support JavaScript, with the

exception of most text-based browsers (e.g., w3m).
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Artisteer.net supports the Lightbox image gallery, which is a JavaScript application used to display

large images.

Meta has several meanings, but generally means information about. In WordPress and Artisteer.net,
meta usually refers to administrative type information. Meta is also the HTML tag used to describe and
define a web page to the outside world (search engines). In the article Post Meta Data, meta refers to

information associated with each post, such as the author's name and the date posted.

Navigation is the term used to describe text on a page that, when selected, redirects you to a
corresponding page elsewhere on the website. Navigation may sometimes be referred to as the menu,

links and hyperlinks.

A Page is often used to present "static" information on a website. A good example of a Page is
information you would place on an About Page. Most websites contain pages and posts. Unlike pages,
posts are time-oriented. In Artisteer.net posts are placed on a Blog Page which is used to display the

post articles added to your website.

Posts are time oriented “articles” that you write to populate your blog.

A slug is an URL friendly version of a title. This is generated automatically by Artisteer.net but you can
change it to be anything you want. Slugs are used with permalinks and they are useful for making

your URLs more readable, particularly to search engines.
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e.g. http://mysite.artisteer.net/2011/09/20/all-about-dogs/

A tag is a keyword which describes all or part of a Post. Think of it like a category, but smaller in
scope. A post may have several tags, many of which relate to it only peripherally. Like Categories,
Tags are usually linked to a page which shows all posts having the same tag. Unlike Categories, Tags

can be created on-the-fly, by simply typing them into the tag field.

Tags can also be displayed in "clouds" which show large numbers of Tags in various sizes, colors, etc.
This allows for a sort of total perspective on the blog, allowing people to see the sort of things your

blog is about most.

Many people confuse Tags and Categories, but the difference is easy: Categories generally don't

change often, while your Tags usually change with every Post.

Trackbacks and pingbacks are two protocols that do essentially the same thing but in different ways.
They help you and other blog authors keep track of the posts on other blogs that are referencing
(linking) to your blog. For example, someone may write a post on a topic that is based on an article on
your blog so they include a hyperlink in the post that refers back to your post. Or, you may write a post
that covers a topic on another blog so you include a hyperlink to another post or page. In either case,
you or the other blog author may want to know who is writing about their blog and using links to posts
on their blog. Links to your content from other blogs may increase your page ranking in search
engines, however you should use care when you link to other sites since many sites and search

engines have particular rules to prevent spamming, or loading up the rank of a page.

Trackbacks are used on older blog systems. These blogs use a special trackback URL. You have to
find this URL in the page content on the blog you want to reference and then add it to the ‘trackback’
attribute where you create your post that refers to the blog. The trackback URL you supplied is used
to notify the other blog when you publish, or update your post. If successful, a special comment is

added to the other blog for the post you are linking to.
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Artisteer.net websites do not support trackbacks. If another blog uses a trackback to send
notifications to Artisteer.net, they will be ignored. When you create a post, do not use the ‘send

trackbacks to’ field to send trackback notifications to another Artisteer.net site.

Pingbacks are similar except you do not have to use a special URL to link to the other blog. All you do
is include a hyperlink (or can be just text) in your post to the other blog’s page or post. Artisteer.net
does support pingbacks. If you link from other Artisteer.net, or wordpress, sites, and you have allowed
pingbacks on your post or page, a special comment will be posted notifying you that another site has
linked to your page or post. Like other comments you can choose, or not choose, to publish these
comments on your website. If you want to reference another blog from your posts, add a hyperlink in
your article to the other page or post of the blog. When you publish your page or post, Artisteer.net
will parse the content and send a ping to the other blog. If the other blog supports pingbacks, it will
respond and normally a special comment will be added to the blog. You can ping pages and posts on
other blogs (if allowed), but you can only include pings (links) in your posts; the links in your pages are

ignored.
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